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Copyright
©1998 General DataComm, Inc. ALL RIGHTS RESERVED.

This publication and the software it describes contain proprietary and confidential information
part of this document may be copied, photocopied, reproduced, translated or reduced to an
electronic or machine-readable format without prior written permission of General DataComm
The information in this document is subject to change without notice. General DataComm as
no responsibility for any damages arising from the use of this document, including but not lim
to, lost revenue, lost data, claims by third parties, or other damages.

If you have comments or suggestions concerning this manual, please contact:

Technical Publications Department
General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut  USA 06762-1299

Telephone: 1 203 758 1811

Trademarks
All brand or product names are trademarks or registered trademarks of their respective com
or organizations.

Revision History

Issue Number Date Description of Change

1 5/1/97 First Issue. V1.2.0 software supports the following Metroplex cards and features:

6-Slot MetropakWall-Mount Enclosure
4-Slot and 8-Slot USS Shelf 
Platform Card and CSU T1 Option Card
Flexi-Voice Plus Basecard; and Dual 0B, Dual TB, Dual 4W&EM, Dual 4WTO, and 
Dual OCU-DP Options Cards
Flexi-Data Basecard and 422/V.11, V.35, and EIA232 Option Cards
Frac-Data Basecard and 422/V.11, V.35, and Frac DSX-1 Option Cards

1 7/1/97 Second Issue. V1.1.0 software supports the following Metroplex cards and features:

All of the above for the first issue, plus --
Dual G.703/64K Option Card on Flexi-Voice Plus Basecard
FXS Octet Basecard
DSX-1 LIU Option Card on Platform Card
Timeslot Allocation

1 1/1/98 Third Issue. V1.2.0 software supports the following Metroplex cards and features:

All of the above for the first issue, plus --
Alarm Detail: E1, HDSL E1, T1, HDSL T1, and MIB Prior to 3.00
6001 Configuration LIU Options: E1, HDSL E1, T1 (CSU or DSX1), and HDSL T1
Alarms Reported: E1, HDSL E1, T1 (CSU or DSX1), and HDSL T1
Alarm Dial-Out
Error Reports (E1) - Main Window, Error Totals (E1), 
Background Block Errors (E1) and Errors Summary (E1)
6521 Frac Data Card
Timeslot Assignment

1 6/1/98 Fourth Issue. V3.0.0 software supports the following Metroplex cards and features:

All of the above for the third issue, plus --
Enhancements are made to E1 service, T1 HDSL, E1 HDSL, and expanded data rate
the MP6441 Frac-Data card.
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Chapter 1: System Description

Introduction
The information contained in this manual has been carefully checked and is believed to be e
reliable. However, as General DataComm improves the reliability, function, and design of th
products, the possibility exists that information may not be current.

If you require updated, or any other General DataComm product information, contact the ad
or number below or visit our web site at:  http://www.gdc.com

General DataComm, Inc.
Park Road Extension
Middlebury, Connecticut 06762-1299  USA

Telephone: 1 203 758 1811
Toll Free: 1 800 794 8246
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 1-1
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Service Support and Training

VITAL Network Services, a General DataComm company, is committed to providing the serv
support and training needed to install, manage, and maintain your GDC equipment.

GDC’s VITAL Network Services provides hands-on training courses through VITAL Network 
Services Global Technology Training Services. Courses range from basic data communication
modems and multiplexers, to complex network and ATM systems. Training courses are ava
at our centers in the US, UK, France, Singapore and Mexico, as well as at a customer’s site

For more information regarding GDC's VITAL Network Services’ service programs, training 
courses, or for assistance with your support requirements, contact GDC's VITAL Network Se
at the address or phone number listed below, or visit our website at:  http//www.vitalnetsvc.com

VITAL Network Services World Headquarters
6 Rubber Avenue
Naugatuck, Connecticut 06770  USA

North America: 1 800 243 1030
1 888 248 4825
1 203 729 2461

Training Information: 1 203 729 0271
French Speaking Canada: 1 800 361 2552
North America Fax: 1 203 723 5012

1 203 729 7611

VITAL Network Services Regional Sales and Service Offices:

Europe, Middle East, Africa
VITAL Network Services
Molly Millars Close
Molly Millars Lane
Wokingham, Berkshire RG41 2QF  UK

Telephone: +44 1189 657200
Training: +44 1189 657240
Fax: +44 1189 657279

Central America, Latin America
VITAL Network Services
Periferico Sur 4225, Desp. 306
C.P. 14210, Mexico  D.F., Mexico

Telephone: +52 5 645 2238
Training: +52 5 645 2238
Fax: +52 5 645 5976

Asia Pacific
VITAL Network Services
501 Orchard Road 05-05
Wheelock Place, Singapore  238880

Telephone: +65 735 2123
Training: +65 735 2123
Fax: +65 735 6889

International Calling Code (+)
When calling from outside the country of origin, use the appropriate International Call-
ing Code where the + symbol is shown.
1-2 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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Safety Information
The DANGERS, WARNINGS and CAUTIONS that appear throughout this manual are not o
preventative measures designed to uphold the safety of both the service engineer and opera
also enhance equipment reliability.

The definitions and symbols for DANGER, WARNING and CAUTION comply with ANSI 
Z535.2, American National Standard for Environmental and Facility Safety Signs, and ANSI
Z535.4, Product Safety Signs and Labels, issued by the American National Standards Instit

The following examples show the symbols and definitions of DANGER, WARNING, CAUTIO
Note and Important as they are used in this manual.

Note Indicates a note. It is something you should be particularly aware of; something not readily 
apparent. A note is typically used as a suggestion.

Important Indicates an emphasized note. It is something you should be particularly aware of; somethin
readily apparent. Important is typically used to prevent equipment damage.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 1-3



System Description Typographical Conventions
Typographical Conventions

Level 1 Heading  paragraph headers introduce major topics. 

Level 2 Heading  paragraph headers introduce subsections of major topics. 

Level 3 Heading  paragraph headers introduce subsections of secondary topics. 

Courier font is used to show text that is displayed on the screen.

Times bold font is used when referring to screen names.

Courier bold font is used to show specific input that you type at 
the keyboard.
1-4 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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Overview

Team 6000 is GDC’s Simple Network Management Protocol (SNMP)-based application for 
network management of the Metroplex 6000 product. Team 6000 is an HPOpenView applic
and has the same look and feel as GDC’s other Team applications. This manual is to be use
application is running on either a Sun/Solaris workstation or on a Hewlett Packard HP-UX pla

Metroplex 6000 is a T1 Access Multiplexer, designed for the delivery of data and voice servic
the customer premises. It provides various combinations of voice and data channels, and a n
connection of one or two T1 lines.

The Metroplex 6000 is available as a wall-mount unit using the 6-slot Metropak, or as a rackm
unit using the Universal Systems Shelf. Four-slot and eight-slot USS backplanes are availab
Thus, depending on the shelf, the capacity can be four, six or eight cards. One of these card
be the Platform card.

The Metroplex cards consist of base cards, which occupy a slot in the enclosure or shelf, an
piggyback option cards, which plug into the base cards and provide various interfaces.

The Platform basecard, MP6001, is the common card for Metroplex. It acts as the manager a
SNMP agent for the other cards. It provides various supervisory ports.   It provides a TERM
for connection to a local VT-100 terminal, a DIAL port for dial-in VT-100 or PPP access, and
SNMP port for Ethernet or PPP access. The Platform card accepts one or two LIU option ca
network interfaces. It also accepts an Ethernet option card, required for LAN-based network
management.

VT-100 management of the Metroplex allows you to configure, monitor and run diagnostics e
from a locally-attached terminal or via a dial-up line. The VT-100 screens can also be used rem
over a LAN using the Telnet protocol. Metroplex 6000 supports both local management via 
100 terminal and SNMP network management at the same time.

For more details on VT-100 Local Management, refer to GDC Publication 086R605-001

The Flexi-Voice Plus basecard, MP6360, provides various voice and four-wire data channe
accepts one, two or three dual-channel option cards, providing up to six channels. Option car
are Originate Battery (OB), configurable for FXS or DPO; Terminate Battery, configurable fo
FXO or DPT; 4-wire E&M, 4-wire Transport Only (4W TO), OCU-DP, and G. 703.

The Flexi-Data basecard, MP6441, provides up to four single-channel data interfaces. Each c
supports rates of 9.6, 56 and 64 kb/s, and is fully DDS-compatible. Option card types availab
EIA232, V.35, 422/V.11, and Async 232.

The Frac-Data basecards, MP6520 and MP6521, provide one or two high-speed data chan
rates of N x 56kb/s or N x 64 kb/s. Option card types available are V.35, 422/V.11, DSX-1, a
Frac-E1.

The FXS Octet card, MP6380, provides eight channels of FXS-type voice, similar to the Dua
Option card on the Flexi-Voice Plus card. The FXS Octet does not accept any option card n
provide any other, except FXS Loop Start, FXS Ground Start, or DPO.

Note To learn how to use HP OpenView, refer to the HP Open View User’s Guide and the HP 
OpenView Administration Reference manual. Also, HP OpenView is available in 0n-line Help
the Team Metroplex 6000 software package.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 1-5
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Installation
For installation instructions, refer to the Installation and Release Notes, Network manager for 
Metroplex 6000 (TEAM 6000) TEAM 6000 V1.3.0 for HP OpenView/Solaris, GDC Publicatio
P/N 086R902-V130; or to Installation and Release Notes SOLARIS and HP Openview, SOLA
2.5.1/HPOV 4.1 Patches, GDC P/N 058R964-000.
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Responsibilities of the TEAM 6000
The TEAM 6000 application is used to manage the Metroplex 6000 cards, which include the
Platform, Flexi-Data, Flexi-Voice, FXS Octet, and Frac-Data cards in combination. Collectiv
the cards handle configuration, diagnostics, and control of the TEAM 6000.

The TEAM 6000 application is also responsible for discovering (Discovery ) and displaying 
(Mapping ) under OpenView . 
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 1-7



System Description Responsibilities of the TEAM 6000
1-8 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01



the 
red 

h are 

may 
 
tion. 

s 
Chapter 2: Discovery

Overview
Discovery , which searches for devices on the network, is integrated with the OpenView IP  
node discovery application. Once an Metroplex 6000 Platform card is discovered, Discovery  
polls the platform card using the Simple Network Management Protocol (SNMP) and takes 
information it gathers for building objects in the OpenView Windows (OVW) database. Monito
by the Metroplex 6000, these objects represent cards in the shelf. Thus, Discovery  is a polling 
routine for the TEAM 6000.

Auto-discovery application polls each new device it encounters to identify those devices whic
Metroplex 6000 Platforms. When the application encounters a Metroplex 6000 Platform, it 
continues to poll for constructing the shelf submap. 

There are times when the data traffic required for auto-discovery becomes a burden on the 
communication network, reducing the throughput of payload data. When that happens, you 
decide to suspend the auto-discover, by either turning off HP OpenView polling through the
Universe submap Options menu or disabling the netmon function of the TEAM 6000 applica

The TEAM 6000 application lets you use the discovery tool manually when auto-discovery i
disabled.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 2-1
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MAP Integration
The following pertain to map integration:

Discovery

• Discovers TEAM 6000-compatible hardware systems in the network and their contents
the cards that they contain.

• Creates the system and equipment objects in the OVW database.

Shelf Map 

• HP OpenView (HPOV) Map  application gets the topology view from the OVW databa
and displays network topology in an open map.

• Updates the topology view (Add/Delete/Modify Systems, Equipment, 
Status ) in response to traps received.

• Creates and maintains (updates) shelf background images.

• Creates images to reflect the shelf contents.
2-2 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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HPOV SNMP Configuration
The Community Names (both Read and Write) set in HPOV SNMP Configuration must ma
the configured Community Names  on the Metroplex 6000 platform card. If they are incorrec
Discovery  can not poll or update the Metroplex 6000 platform card. 

The SNMP Configuration selection appears in the Options menu of the HPOV menu bar that 
appears at the top of all map windows. 
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 2-3
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Database
The Shelf Map function develops the following types of database objects:

1. • Root Object

2. • Metroplex 6000 Platform Shelf Object

3. • Objects for different types of cards

The Root  object is the parent object of the TEAM software. The Root symbol is created from
object and all Submaps extend from this symbol. There is only one Root object per OpenVie
database.

The Metroplex 6000 Platform Shelf object serves as a logical addressing entity for Metroplex
Platform cards. This deals with multiple IP addresses for the same shelf. 
2-4 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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Shelf Map 

The Shelf Map  function is an integrated application under OpenView , responsible for 
displaying objects in OpenView . It displays the network in a hierarchy of submaps, multiple lev
deep:

• Universe Submap  — contains the Metroplex 6000 Platform shelves found by 
Discovery .

• Shelf Submap  — displays all the devices in a shelf.

• Interfaces Submap  — displays all the interfaces for a selected device in a shelf. T
Interfaces Submap  for a master device (the local, or central site, unit controlled by 
TEAM software) also contains the remote unit(s) associated with the master. 

Startup

The Shelf Map function starts automatically when OpenView Windows starts. As an OpenV
program, it runs only when executed by OpenView.

Shelf Map Synchronization

The Shelf Map  function enters its synchronization phase when it is started. While the Shelf 
is synchronizing, OpenView displays a Synchronizing message on the status line of the sub
displayed. During synchronization, the Shelf Map function creates symbols for new network
objects to update the Submaps that use the database. It also updates alarm status. During t
the Shelf Map function cannot respond to some OpenView requests and you cannot access
functions. For example, OpenView restricts you from deleting symbols and objects while an
application is synchronizing. Also, the Shelf Map does not appear in the list of applications in d
boxes until it completes its initial synchronization. When the Shelf Map is finished with 
synchronization, it enters a mode where it handles incoming OpenView events and topology
changes.

The Shelf Map function also displays the synchronizing message during operations that take
time, such as updating a shelf graphic. The Shelf Map synchronizes in conjunction with othe
OpenView applications. A synchronizing message may result from any one of the applicatio
synchronizing.

Shelf Map Editing

The Shelf Map supports map edits accomplished through the OpenView user interface. The
several ways to modify the map through the user interface, including: add, delete, and cut/p
symbols. As mentioned above, you can not access these operations during map synchroniz

Addition of symbols includes both icon and connection symbols, accessed by different menu
in OpenView. The Shelf Map function does not accept additions of icon or connection symbo
the application plane of the map. You can, however, add any symbol to the user plane.

The Shelf Map function supports the deletion of symbols from the map. Deleting an object fro
map also clears it from the Metroplex 6000 for UNIX tables. 

The cut and paste operations are supported by Map. But the result of the paste is a symbol in the
user plane of the map. The status of the symbol is kept synchronized with the device it repre

Refer to the HP OpenView User’s Guide for additional detail. 
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 2-5
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TEAM6000 Universe Submap

The TEAM6000 UNIVERSE submap is accessed through the Root  symbol in the OpenView 
Root Submap . It contains a symbol for each Metroplex 6000 Shelf discovered. On each m
there is only one Universe Submap. Figure 2-1 displays a typical TEAM6000 UNIVERSE submap 
screen.

Figure 2-1 Typical TEAM 6000 Universe Submap Screen

You can modify them using the Describe/Modify Object  Dialog Box. The label of the 
system is the text name as assigned in the system configuration application. Events  in the 
Events Category  application reference the shelf selection name as the source of the eve

Shelf Submap

The Shelf symbols on the TEAM6000 UNIVERSE submap provide access to Shelf Submaps. 
Shelf Submap  contains a symbol for each card in the corresponding shelf.

The Metroplex 6000 Platform card proxies SNMP messages to the other cards in the shelf. 
maintains a table of all cards in the Shelf. 

You can execute applications by selecting a symbol in the Shelf Submap  and then choosing a 
menu item that corresponds to an application. Figure 2-2 displays a typical Shelf Submap screen
2-6 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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Figure 2-2 Typical Shelf Submap Screen

Slot Deletion

The Metroplex 6000 discovers each card in a shelf and holds the information until it is delet
the TEAM software. Physically removing a card from a shelf or disconnecting a device from
system does not delete it from the Shelf Submap. To properly remove a card or other devic
the system you must both physically remove it and remove it from the Metroplex 6000 Node 
Table .

To remove:

1. Physically remove the device from the system. In the case of a central site device, that 
removing the card from the shelf. In the case of a remote device, that means disconnec

2. At the TEAM workstation, select the shelf from the Shelf Submap . 

3. Choose the device you are deleting, pull down the Edit  menu, and select Delete  from all 
submaps.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 2-7
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Background Images

The Shelf Map  function can represent the Metroplex 6000 Shelf and its contents in an Open
background image. The image is synchronized with the current shelf configuration and displa
shelf with all Metroplex 6000 platform cards in the proper locations. Shelf Submap symbols 
aligned with their corresponding card images in the background image.

You can set this capability using the Map Configuration Dialog  Box. The default 
configuration is to enable background graphics.

Symbol Types

As the highest level in the Submap hierarchy, the Root  symbol is your access to the system in 
OpenView. This symbol is created in the OpenView Root Submap. Access the Universe Su
by double-clicking on this symbol.

The Shelf symbol is the logical representation of the Metroplex 6000 Shelf in the Network. E
physical shelf on the network has a corresponding Shelf symbol in the Map. Yet this symbo
represents more than just the Metroplex 6000 Platform card--it stands for all the cards in the
The Shelf symbol is an access point to the Shelf Submap. Open the Shelf Submap by doub
clicking on this symbol.

The Metroplex 6000 symbol represents the platform card in the Metroplex 6000 Shelf. Ther
two places in OpenView where this symbol is found: (1) IP Map creates this symbol in the 
Internet Submap  when discovered by netmon to be a Metroplex 6000 application. Here,
symbol represents the IP Map view of the Metroplex 6000 Platform card; and (2) the Shelf M
function initiates the Metroplex 6000 symbol on the Shelf Submap , where this represents the 
Metroplex 6000 Platform card within the shelf. Built using the object discovered by netmon, 
symbol has a status source which is set to Compound (Propagate).

Symbol Labels

As a convenience, you can change a target name by modifying its string so that you can kee
of shelf name, slot number, and symbol label, which are programmatically determined. These
items are identified in this format: <shelf  name:slot number , symbol  label> . Let’s say 
you have Shelf11234:5 , slot 5  and you want to change the shelf name to Hartford Hub  
and the symbol label of the 5553 in Slot 5 to WTBY (Waterbury link). The target name string is now
Hartford Hub:5 , WTBY and is used as a target identifier for the application on the base win
and all subordinate dialog box windows. Moreover, this function specifies the application ico
bitmap file name and the icon label. The icon label then becomes the symbol label of the targ
element which had launched this application.

 illustrates this concept here.
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Figure 2-3 Modifying Symbol Label

Metroplex 6000 Application Misidentification

During set up of a new system, it can occur that HPOV Discovery runs before the TEAM 
application software is installed. If a Metroplex 6000 application is discovered when this hap
it is added to the IP submap as a generic object.

When the application software is in place, the generic object prevents the Metroplex 6000 
application from being discovered and correctly identified. If a Metroplex 6000 application is
misidentified, it can not function for the TEAM applications. But if this occurs, delete the 
Metroplex 6000 generic object and ping the device so that the Metroplex 6000 application is
discovered correctly and identified by a Metroplex 6000 object. 

Root Map

IP Team 

TEAM6000 Universe

MP 6004

This symbol label is programmatically determined, 
and by clicking on the right mouse button, you can 
edit this symbol label. Whatever name you choose, 
some alphanumeric characters at both ends of the 
string are automatically truncated to fit the field 
space.

Metroplex Shelf MP6004

Hartford 

MP 6004

Hartford HUB

600 636

Slot 

WTBY Name: HARTFORD HUB: 2, WTBY

Then, you see this target 
name on a launched applica-
tion, such as Configuration, 
etc.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 2-9



Discovery Rediscovery and Alarm Synchronization

nts 

 

Rediscovery and Alarm Synchronization
You can run Synchronization  on-demand by selecting Poll Shelf  from the fault menu in 
the HPOV menu bar that appears at the top of map and submap windows. 

The time it takes the Poll Shelf  application to run varies according to the number of eleme
in the shelf. The Discovery  and Alarm Synchronization  functions can interfere with 
primary data flow while they are running.

Note If the OpenView  windows are exited while either of these windows is open, it remains open until you
close it manually.
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Manual Discovery  lets you identify a Metroplex 6000 card for the TEAM application, there
instructing the application to poll the Metroplex 6000 and construct a shelf submap for it and
devices it controls. This process is not required while the application is performing auto-disco

If the size of the network, where the application is operating, precludes auto-discovery, you 
disable auto-discovery within the TEAM 6000 application itself by (1) stopping the netmon ta
that Shelf Discovery  needs for operation, or by (2) disabling auto-discovery with HP 
OpenView  by the Universe submap Options menu. Both methods are described below. 

To Disable Auto-Discovery by Stopping Netmon

Within the TEAM application, operation of the auto-discovery process is governed by a Loca
Registration File (LRF) called discover.lrf  that is located in the directory /usr/OV/lrf . 
To disable auto-discovery by turning off netmon you need to modify that file by carrying out 
following steps: 

1. Open a shell tool on your workstation. 

2. Stop the Shelf Discovery process by typing 

/opt/OV/bin/ovstop shelf_discovery

3. Make a backup copy of the discover.lrf  file so that it can be reloaded later in its 
original form if needed. 

4. Load the discover.lrf  file into an editor so that you can modify it. 

5. Locate the following two lines in the file

opt/OV/bin/shelf_discovery:

OVs_YES_START:trapd,ovwdb,netmon::OVs_WELL_BEHAVED:15

6. Delete ,netmon  from the second line and save the file. The two lines should now read 

opt/OV/bin/shelf_discovery:

OVs_YES_START:trapd,ovwdb::OVs_WELL_BEHAVED:15

7. To update the process configuration, run OpenView Add Object  on the 
discover.lrf  file by typing 

/opt/OV/bin/ovaddobj /usr/OV/lrf/discover.lrf

8. Restart the Shelf Discovery  process by typing

/opt/OV/bin/ovstart shelf_discovery

To Disable Auto-Discovery by Turning Off OpenView Polling

The auto-discovery process is part of the Status Polling  procedure carried out by the HP 
OpenView software. To disable auto-discovery by controlling OpenView  polling, carry out the 
following steps:

1. Display the Universe  submap. 

2. From the Options  menu, select Network Polling . Configuration:IP
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3. In the resulting dialog box deselect either Perform Status Polling , to suspend all 
automatic polling by the OpenView software, or Discover New Nodes , to suspend only 
polling for the discovery process. 

4. Dismiss the dialog box. 

To Perform Manual Discovery

Before you can perform manual discovery on a Metroplex 6000, it must be configured with t
appropriate community name and you must be able to communicate with it. To perform man
discovery carry out the following steps:

1. From the Options  menu, select SNMP Configuration  and make sure that the 
Metroplex 6000 has the proper Community Configuration . 

2. Make sure you can communicate with the Metroplex 6000 by pinging it and issuing an
snmpwalk  command. If this does not work, check the routing tables in the workstation
make sure that there is a route available to the Metroplex 6000. 

3. Display the IP submap of the segment to which the Metroplex 6000 is connected. 

4. From the Edit menu, select Add Objects . 

5. In the resulting window select the Computer  symbol class. 

6. Modify the symbol by using the middle mouse button to drag the Metroplex 6000  
Symbol Subclass onto it on the IP submap. 

7. In the Add Objects  dialog box, enter the label assigned to the Metroplex 6000. 

8. Set the IP Map Object Attributes . Be sure to enter both the hostname and the I
address.

 When the process is completed, the Shelf Discovery  application polls the Metroplex 6000 
System and draws the shelf topology based on the information it receives from the Metroplex

Note If a valid hostname is not available, enter the IP address of the Metroplex 6000 in the Hostname  field.
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Chapter 3: Operations

Introduction
The TEAM 6000 software application consists of a group of smaller applications, each devo
a specific aspect of controlling or monitoring functions administered by the Metroplex 6001 
Platform card and five subordinate cards 6360, 6380, 6441, 6520, and 6521. This chapter fu
describes the Front Panel , Maintenance , and Information  status functions. 
Configuration functions are covered in Chapter 5, Platform Card, Chapter 6, Flexi-Voice Card, 
Chapter 7, Flexi-Data Card, Chapter 8, Frac-Data Card, Chapter 9, FXS Octet Card, and Chapter 
10, E1 Frac-Data Card. 
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Common Window Features
Each 6000 TEAM application you select opens an on-screen window in which to operate. A nu
of features are common to many of the windows: 

Descriptions in this manual of the individual 6000 TEAM applications identify window featur
specific to the applications, such as selections in the menu bar and menus, and buttons. 

Control Function and Location

Triangle button In the title bar (present only when TEAM software is operating on a Sun workstation), but
the window to an icon when you click on it. Double-clicking on icon restores the window. Th
appears on the top level window for each application.

Title bar Identifies the specific TEAM application running in the window, for example, Metroplex 6
figuration or DSE Highway Configuration 

Menu bar Always contains the selections File , on the far left, and Help , on the far right. File menu alw
contains the selection Exit , where you can dismiss the window. Some window file menus 
selections special to the window. Help menu lets you read information concerning the wind
windows have additional menu bar choices. 

The menu bar appears on the top level window for each application. 

Name field Identifies the Metroplex 6000 that is currently connected to by displaying the user-config
name, followed by the Metroplex 6000 slot number. 
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Map Window Menu Bar Access
You can access TEAM application functions from the menu bar in two HP OpenView map 
windows: the TEAM 6000 Universe  map by selecting on a shelf icon, or a shelf submap by 
selecting on a Metroplex 6000 icon. Figure 3-1 is a simple drawing of a path leading from the Root  
screen to the Team 6000 Universe screen where you can select that icon.

Figure 3-1 Accessing Metroplex 6000 with an Icon from the TEAM 6000 Universe 

The first of the two following tables illustrates how the TEAM application functions are arran
on the menu bar at the top of the HPOV TEAM Universe Map window. The second shows t
functions that appear on the menu bar of a shelf submap. The tables show only the menu se
for the TEAM 6000 applications. Map window menus also include selections in addition to th
that apply to TEAM 6000 because the windows also provide access to other applications. 

You must select the shelf or Metroplex 6000 you intend to work with before you open the men
intend to use. Select by clicking the mouse on the appropriate icon. Below is a display of the T
Universe Map menus: 

Menu Bar Menu Selections

Configuration

Timeslot Assignment... 

Fault

Poll Shelf...

Shelf Selftest...

Menu Bar Menu Selections

Misc

Front Panel Poll Rate...

App Info...

Root

TEAM 6000IP Internet

TEAM 6000 Universe

MP6000
-mp6-
0024510

MP6000
-mp6-
0015014

MP6000
-mp6-
003

click on this

and get this screen

then click on an

with mouse

the icon like
this one, for example 
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Monitor Functions

Front Panels

A Metroplex 6000 Front Panel display window (See Figure 3-2) provides graphical interfaces with
the Metroplex 6000 cards: Metroplex 6001 Platform , 6360 Flexi-Voice+ , 6380 FSX 
Octet , 6441 Flexi-Data , 6520 Frac-Data , or the 6521  Frac-Data . You can launch 
a front panel in either of two ways:

• Select the unit you intend to work with in the HPOV Map window, then select Front  Panel  
from the Performance  menu for that window.

• Display the shelf sub-map that includes the unit you intend to work with, then double-c
the mouse on the slot icon for the unit.

The application responds by displaying a window depicting one of the Metroplex 6000 front pa
In addition, the bottom of the front panel display contains a Select  button, a Status  field, and a 
Help  button. The Select  button provides access to the TEAM application menus for the 
Metroplex 6000 cards. The status field displays information on communications between the
application and a Metroplex 6000 card. The Help  button gives you help information concerning th
front panel display. 

The LEDs shown in the display of the front panels reflect the states of the actual indicators 
physical units (See Figure 3-2). A LED appears bright green or red to indicate ON or grey to indicate 
OFF. The LEDs in the displays of the front panels show the current states of the LEDs on th
physical units. The select button, at the bottom of the front panel image, lets you see the me
the rest of the TEAM 6000 application functions. The diagram and table on the following pa
show the arrangement of the select button menus on the front panel for the Metroplex 6001 P
Card (Refer to the hardware manuals).
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Figure 3-2 Metroplex 6000 Front Panels

The menu depends, of course, on what particular 6000 Metroplex card or front panel you ha
installed or operating. The diagram below is merely an example of what you could select fro
button menu.

MP6000-m MP6000-m MP6000-mMP6000-m MP6000-mMP6000-mMP6000-m
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The two poll selections in the Select  button menu determine when the application collects ne
information from the Metroplex 6000 cards to update the front panel window:

• Selecting Demand Poll  causes an immediate update of the display. 

• Auto Poll  lets you choose updates at 15, 30, or 60 second intervals, or to disable auto
polling. If you select Disable , the front panel window displays a static snapshot of the LE
states as they were at the last poll, either when the window was launched, or at the tim
subsequent Demand Poll . 

The menu selection Exit  dismisses the front panel window when you click on it. 

Select Button Menu Selections

Performance

Alarms Detail...

Reports...

Configuration

Configuration...

Reset...

Fault

Diagnostics...

Demand Poll

Auto Poll (*)

15 seconds

30 seconds

60 seconds

Disable

Exit * Displays Off or poll interval
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Configure Functions

Reset

You can launch the TEAM Reset  application from the shelf submap Configuration  Menu or 
the front panel Select  button Configuration Menu. The application displays the Maintenance
window for the selected Metroplex 6000.

Metroplex 6000 Configuration

The Metroplex 6000 Configuration application displays windows for configuring the Metrople
6001 with IP addressing and routing, and for specifying trap destinations. This application is
accessible under Select--->Configuration--->Navigate--->Trap Options , IP 
Routing Options , and Community Name Options  in a shelf submap menu bar button 
menu of the Metroplex 6001 front panel display. Chapter 5 describes Metroplex 6000 
Configuration in detail.

Note There is a general SNMP error is displayed when you to try to change configuration or save the 
configuration to a file while a diagnostics test is active.
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Miscellaneous (Misc) Functions

Information

You can launch the TEAM Information application from the HPOV Universe Map Misc 
Menu or the shelf submap Misc Menu . The application displays the read-only Information  
window for the selected Metroplex 6000 (See Figure 3-3), where Misc---->AppInfo...  
produces this screen.

Information  displays one read-only window that contains the name of the application, soft
revision level information, and copyright information. The File  menu in the menu bar contains 
only the selection Exit , where you can dismiss the window.

 

Figure 3-3 Information Window for the TEAM 6000
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Chapter 4: Universe Map Operations

Configuration

Metroplex Timeslot Assignment

Designed to monitor the timeslot allocation of the Metroplex LIU, the Metroplex Timeslot 
Assignment interacts with the various configuration applications running on the same work-s
and furnishes real-time updates to timeslot assignments. If timeslot assignments change, th
configuration applications notify the Timeslot Assignment application, and then the Timeslot
Assignment application reads the LIU assignment and channel status information from the 
Metroplex 6000. Thus, the display gets updated. 

When you select a shelf on the 6000 Universe sub-map, you can launch the Metroplex Time
Assignment Application from the HPOV Map Application, by way of the Main Configuration 
Window, which is read-only. There is only one main window and it handles the timeslot alloc
for both LIU-A and LIU-B. Figure 4-1 shows the Metroplex  Timeslot  Assignment  screen. 
When CAS is on, Timeslot 16  displays Signalling .

Menu Bar Menu Selections

Configuration

Timeslot Assignment 

Fault

Shelf Selftest...
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Figure 4-1 Metroplex Timeslot Assignment Screen (Platform Card)
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On the title bar is the application name, Metroplex  Timeslot  Assignment . The menu bar 
has File  for file operations and your basic Help  info. The main part of the screen has fields th
are read-only and the status message area (lower right) tells you about current status of the
application and unit interaction. Below is a summary of the menu button functions for the tim
assignment application.

Arrayed in Table 4-1 below are three groups of data fields for the Metroplex Timeslot Assignm
along with their definitions and functions. These three categories are Name, LIU A, and LIU B
LIU groups contain identical column fields for the specific LIU. Fields are defined only once. 
LIU B group is not displayed if the shelf does not contain LIU B. Table 4-2 shows you the 
Metroplex Timeslot Assignment file Menu (Platform Card).

Table 4-1 Metroplex Timeslot Assignment (Platform Card)

Menu Buttons Menu Selections Results in:

File

Refresh Reading LIU assignment information from the 
unit.

Exit Terminating application.

Help

Displaying help information.

Field Displayed (Read-only) Description

Timeslot Off , 1, 2,...., 31 For a T1 LIU, Timeslots 25 -31 are grayed out.

S:C -
(Slot:Channel)

Examples for LIU  A are 
4:1 , 4:2 , 4:3 , 3:1 , 1, 
5:1 , *5:2 , and so on.

Examples for LIU  B are 
7:1 , 6:2 , 6:1 , 6:1 , 6:1 , 
1, and so on.

Identifies slot (*for example, Slot 5) and channel (*for example, Cha
nel 2) of the card using the timeslot. When a timeslot is assigned to
& I, only the slot number of the platform card is displayed. Field is 
blank if the timeslot is unassigned.

- Card Type Examples are *6360  E & M, 
6360  Orig  Batt , 6001  D 
& I  Sig , and so on.

Represents card number (*for example, Card 6360) and channel ty
(*for example, Card Type E & M) using the timeslot. Field is blank i
the timeslot is unassigned.

Status
(Channel status)

Test , OK, Fail , Alarm , 
or --

Reflects the status of the card in the timeslot. The double dash, -- , is 
used when the channel status does not apply, for instance, when th
timeslot is assigned to D & I  as shown in the accompanying figure 
above. Field is blank if the timeslot is unassigned.

Note: Defaults in bold.
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Figure 4-2 Metroplex Timeslot Assignment File Menu (Platform Card) 
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Shelf SelfTest

A selftest can be performed on the shelf, where six slots, each holding a type of card, can be
The results are displayed above the Shelf Selftest  action menu after the selftest is run. Exitin
and returning to the screen clears the selftest result (See Figure 4-3 and Figure 4-4). Refer to
Table 4-2.

Figure 4-3 Selftest Screen for Six Channels (6001 Card)

Figure 4-4 Selftest Screen for Eight Channels (6001 Card)

Table 4-2 Selftest Selections and Messages (6001 Card) 

Field Slot Number Selection Description

Card Type Platform, Frac-Data,
Flexi-Data, Flexi-Voice Plus, FXS 
Octet unspecified or unknown

Specifies card type read from card. Unknown indi-
cates Platform card does not recognize Card Type
Check the firmware revision.

Status Passed, Failed Indicates the current status of the self-test. Failed 
means the card did not pass selftest.

History
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Chapter 5: Platform Card

Introduction
The Platform basecard, MP6001, is the common card for Metroplex. It acts as the manager a
SNMP agent for the other cards. It provides various supervisory ports.   It provides a TERM
for connection to a local VT-100 terminal, a DIAL port for dial-in VT-100 or PPP access, and
SNMP port for Ethernet or PPP access. The Platform card accepts one or two LIU option ca
network interfaces. It also accepts an Ethernet option card, required for LAN-based network
management.

VT-100 management of the Metroplex allows you to configure, monitor and run diagnostics e
from a locally-attached terminal or via a dial-up line. The VT-100 screens can also be used rem
over a LAN using the Telnet protocol. Metroplex 6000 supports both local management via 
100 terminal and SNMP network management at the same time. (For descriptions of the fron
LEDS, refer to the hardware manual. Note also that flashing LEDs are not supported.)
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Platform Card (6001)
The performance and configuration information for the Platform Card (6001) is presented in
chapter. You can access Performance  from the main menu bar or from the front panel select
switch.

Alarm Details Menu

Alarm detail selections bring you the following screens, where the alarm detail screens vary
the option cards installed on the base card: E1, HDSL-E1, T1, HDSL-T1, and the MIB (prior
3.00). 

E1 Alarm

See Figure 5-1 and refer to Table 5-1.
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Figure 5-1 E1 Alarm Detail Screen (6001)
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Table 5-1 E1 Alarm States (6001) 

Network and Timeslot 16 LED Indications

Out Of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm Indication Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

Loss of Signal Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

Near End and Far End

Line Code Violation
           (near-end only)

Line Code Violation  (LCV) event for a HDB3 coded signal is the oc-
currence of a received bipolar violation that is not part of a zero-substitutio
code.

Errored Seconds An errored second (ES) is defined as a second with at least one CRC erro
event.

Severely Errored Seconds A severely errored second (SES) is defined as a second with 320 or more 
CRC6 error events, or one or more OOFs.

Unavailable Seconds Unavailable errored seconds (UAS) is defined as a count of one-second in
vals when service is not available.

Background Block Errors Since an errored block is a block having one or more bits which are in erro
we define a Background Block Error  (BBE) as an errored block not 
occurring as part of an SES (Severely Errored Second) event.

Timeslot 16

Out of Frame LOS (Loss Of Signal) or OOF (Out Of Frame) is detected as defined in TR
62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Loss Of Signal Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

Power Supply (LIU A only)

Internal Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

External Power Supply LED lights up red if the external power supply malfunctions or is not availab

Note:

When LIU B  is not active, the alarm detail screen is removed from the screen and reduced horizontally in size. 
CAS is off, then the power supply alarms are displayed instead of the Timeslot 16 alarms.

When CAS is off, the Timeslot 16 alarms are removed from the screen. For the LIU A, this causes the power su
alarms to move into the screen position normally occupied by the Timeslot 16 alarms. 

When CAS is off on both LIUs, or CAS is Off on LIU A and LIU B is not active, then Timeslot 16 alarms are remo
from the screen, causing it to reduce in size vertically.

If the shelf type is USS, the power supply alarms are removed from the screen and reduced in size vertically.
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HDSL-E1 Alarm

See Figure 5-2 and refer to Table 5-2. 

Figure 5-2 HDSL-E1 Alarm Detail Screen (6001)
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Table 5-2 HDSL-E1 Alarm States (6001) 

Network and Timeslot 16 LED Indications

Out Of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm Indication Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

Near End and Far Ends

Errored Seconds An errored second (ES) is defined as a second with at least one CRC erro
event.

Severely Errored Seconds A severely errored second (SES) is defined as a second with 320 or more 
CRC6 error events, or one or more OOFs.

Unavailable Seconds Unavailable errored seconds (UAS) is defined as a count of one-second in
vals when service is not available.

Background Block Errors Since an errored block is a block having one or more bits which are in erro
we define a Background Block Error  (BBE) as an errored block not 
occurring as part of an SES (Severely Errored Second) event.

HDSL

Remote Loss Of Signal Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

Loss Of Signal Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

Loop 1 Loss Of Signal Red indicates LOS (Loss of Signal) for Loop 1 is detected as defined in TR
62411.

Loop 2 Loss Of Signal Red indicates LOS (Loss of Signal) for Loop 2 is detected as defined in TR
62411.

Loop 1 Loss Of Sync Advises you that there was no framing on the U-loop signal (or it has been lo
for Loop 1.

Loop 2 Loss Of Sync Advises you that there was no framing on the U-loop signal (or it has been lo
for Loop 2.

Major Bit Error Rate Major Bit Error Rate based on threshold. Threshold: 10E-03, 10E-04, 10E-0
and 10E-06 bit error rates.

Minor Bit Error Rate Minor Bit Error Rate based on threshold. Threshold: 10E-03, 10E-04, 10E-0
and 10E-06 bit error rates.
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T1 Alarm

See Figure 5-3 and refer to Table 5-3. 

Power Supply (LIU A only)

Internal Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

External Power Supply LED lights up red if the external power supply malfunctions or is not availab

Note:

When LIU B  is not active, the alarm detail screen is removed from the screen and reduced horizontally in size. 
CAS is off, then the power supply alarms are displayed instead of the Timeslot 16 alarms.

When CAS is off, the Timeslot 16 alarms are removed from the screen. For the LIU A, this causes the power su
alarms to move into the screen position normally occupied by the Timeslot 16 alarms. 

When CAS is off on both LIUs, or CAS is Off on LIU A and LIU B is not active, then Timeslot 16 alarms are remo
from the screen, causing it to reduce in size vertically.

If the shelf type is USS, the power supply alarms are removed from the screen and reduced in size vertically.

When one LIU is HDSL-E1 and the other is E1, the LIU contains only those alarms appropriate for that particular
that is, the screen combines both the E1 and HDSL-E1 screens.

Table 5-2 HDSL-E1 Alarm States (6001)  (Continued)

Network and Timeslot 16 LED Indications
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Figure 5-3 T1 Alarm Detail Screen (6001)

Table 5-3 T1 Alarm States (6001)

Network LED Indications

Out Of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm Indication Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.
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HDSL-T1 Alarm

See Figure 5-4 and refer to Table 5-4. 

Loss Of Signal Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network. Red indicates LOS (Loss of Signal) is detected as define
in TR 62411.

Bipolar Violations Allowing this alarm enables Bipolar Violations Threshold  and
Bipolar Violations Window .

CRC Allowing this alarm enables CRC Threshold  and CRC Window.

Errored Seconds An errored second (ES) is defined as a second with at least one CRC erro
event.

Severely Errored Seconds A severely errored second (SES) is defined as a second with 320 or more 
CRC6 error events, or one or more OOFs.

Unavailable Seconds Unavailable errored seconds (UAS) is defined as a count of one-second in
vals when service is not available.

Bursty Errored Seconds A bursty errored second (BES) is defined as a second with more than one,
less than 320 CRC6 error events.

LIU A only

Internal Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

External Power Supply LED lights up red if the external power supply malfunctions or is not availab

Note:

When LIU B  is not present, it is removed from the screen and is reduced in size horizontally. 

If the shelf type is USS, the power supply alarms are removed from the screen and reduced in size vertically.

Table 5-3 T1 Alarm States (6001)

Network LED Indications
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Figure 5-4 HDSL-T1 Alarm Detail Screen (6001)
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Table 5-4 HDSL-T1 Alarm States (6001) 

Network LED Indications

Out Of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm Indication Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

CRC Allowing this alarm enables CRC Threshold  and CRC Window.

Errored Seconds An errored second (ES) is defined as a second with at least one CRC erro
event.

Severely Errored Seconds A severely errored second (SES) is defined as a second with 320 or more 
CRC6 error events, or one or more OOFs.

Unavailable Seconds Unavailable errored seconds (UAS) is defined as a count of one-second in
vals when service is not available.

Bursty Errored Errors A bursty errored second (BES) is defined as a second with more than one,
less than 320 CRC6 error events.

HDSL

Remote Loss Of Signal Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network. 

Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

Loop 1 Loss of Signal Red indicates LOS (Loss of Signal) for Loop 1 is detected as defined in TR
62411.

Loop 2 Loss of Signal Red indicates LOS (Loss of Signal) for Loop 2 is detected as defined in TR
62411.

Loop 1 Loss of Sync Advises you that there was no framing on the U-loop signal (or it has been lo
for Loop 1.

Loop 2 Loss of Sync Advises you that there was no framing on the U-loop signal (or it has been lo
for Loop 2.

Major Bit Error Rate Major Bit Error Rate based on threshold. Threshold: 10E-03, 10E-04, 10E-0
and 10E-06 bit error rates.

Minor Bit Error Rate Minor Bit Error Rate based on threshold. Threshold: 10E-03, 10E-04, 10E-0
and 10E-06 bit error rates.
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Alarm - MIB Version Prior to 3.00

See Figure 5-5 and refer to Table 5-5. 

Figure 5-5 Alarm Detail Screen - MIB Prior to 3.00 (6001)

LIU A only

Internal Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

External Power Supply LED lights up red if the external power supply malfunctions or is not availab

Note:

When LIU B  is not present, it is removed from the screen and is reduced in size horizontally. 

If the shelf type is USS, the power supply alarms are removed from the screen and reduced in size vertically.

When one LIU is HDSL-T1 and the other is T1, the LIU contains only those alarms appropriate for that particular
that is, the screen combines the T1 and HDSL-T1 screens.

Table 5-4 HDSL-T1 Alarm States (6001)  (Continued)

Network LED Indications
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6001 Error Reports - Overview

This section describes various error reports (statistics) screens for MP 6001 LIUs with T1 an
HDSL, or E1 and E1-HDSL interface types. Several screens have been added to support the
HDSL, and E1-HDSL interfaces. There are some cosmetic changes and additions to every 
from the previous release. Some of the added features are:

• New background color(bisque) for graphs to emphasize graphical data

• Auto-ranging of Y-Axis

• X-Axis glyph labels lead to pop-up windows by point and click

• Real-time representation of the intervals

• Interval based graphs have scrolling capability to view all 24 hours worth data

• Periodic polling for data

The above features are described in the next sections. As the screens for T1, T1-HDSL, E1
HDSL, and the screens for individual attributes (like ES or SES) are very similar; only the common
set of screens are covered in the following text. 

Only screens for E1 are described here as T1, T1-HDSL, and E1-HDSL screens look the sa
E1 without the far end statistics or fewer statistical attributes being reported. Any difference
between T1, T1-HDSL, E1, and E1-HDSL are pointed out as required. These screens are de
in detail:

• Metroplex 6001 Error Reports (E1) - Main Window

• Metroplex 6001 Error totals (E1)

Table 5-5 Alarm States Screen - MIB Prior to 3.00 (6001) 

Network LED Indications

Out Of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones Signal AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm Indication Yellow indicates a RAI (Remote Alarm Indication) is being received from th
network. Blue indicates an AIS (Alarm Indication Signal) is being received 
from the network.

Loss of Signal Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

LIU A only

Internal Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

External Power Supply LED lights up red if the internal power supply malfunctions or is not availabl

Note:

When LIU B  is not present, it is removed from the screen and is reduced in size horizontally.

If the shelf type is USS, the power supply alarms are removed from the screen and reduced in size vertically.
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• Metroplex Background Block Errors(E1)

• Metroplex 6001 Errors Summary (E1)

Description of MIB objects and terms

mp6001StatsLastInitialized (MIB Object)

This object keeps the time elapsed (time-ticks) from the time the statistics was last reset or th
was reset. This object is key to interpreting data in terms of real-time. The maximum value t
object can hold is 2^32=4294967296  (497 days, 2h:27m:52s). The application does not han
roll-over of this value and requires a statistics reset at least once every 497 days. A sample v
used here to show how it is used to calculate real-time relative to the workstation (manager

value = 18330000 time-ticks = 2 days 2 hours 55 minutes

The minutes value indicates data was dumped into the most recent interval 10 minutes ago
current time on the workstation is 11:55  then at 11:45  data was dumped into the most recent 
interval. The time for the remaining intervals is simply 15 minutes less down the time line.

The hours and minutes values indicate how long ago the current 24 hour totals have been d
into the recent 24 hour totals. In this sample, it was 2 hours and 55 minutes ago. If the curre
on the workstation is 11:55 , then at 9:00, the current 24 hour totals were transferred to the re
24 hour totals. Also, the current 24 hour totals data were cleared in the unit. The values in the
24 hour totals at this time (9:00) represents data for times 9:00 (Thursday) to 9:00 (Wednes

Auto Ranging

This feature dynamically changes the Y-Axis scale depending on the maximum value of any
attributes on the X-Axis. If the value for a certain attribute (or interval) is 100 , then the Y-Axis 
maximum value is 100 . When the X-Axis value for an attribute changes to 500  the Y-Axis 
maximum changes to 500 . This way the graphs are more readable when the values for all attrib
(or interval) fall within the same range.

Error Reports (E1) - Main Window

See Figure 5-6. The Error Reports (E1) Main Window  screen application is used to 
display statistics accumulated by the Metroplex 6001 Platform card. You can launch this pla
card screen from the HPOV Shelf Map. This screen is the starting point for all other screens
screen contains several input areas. Each of the areas is described below. The main window 
of two glyphs (buttons), which when clicked, open up the totals screen and error summary s
The LIU selection abbreviated menu (choice menu) has six selections, which are: LIU A , LIU A 
- Loop 1 , LIU A - Loop 2 , LIU B , LIU B - Loop 1 , and LIU B - Loop 2 . This 
list makes selections unavailable, depending on the hardware configuration. 
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Figure 5-6 Error Reports (E1) - Main Window (6001)

The Navigate  menu of the summary window lets you access individual windows showing m
detailed statistics on each error condition. The menu bar contains the menu cells File , Edit , 
View , and Navigate .

File

See Figure 5-7.

Figure 5-7 File->Auto Refresh Screen (6001)
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The menu item File->Refresh  is an on-demand update of the data for the selected LIU (loo
The File->Auto Refresh  has menu items to periodically poll the unit for data and update
screens. The menu item File->Auto Refresh->Off  disables periodic poll and any other 
option, periodically refreshing at a selected value. Selection of poll time is dynamically appe
to the menu item File->Auto Refresh  (Example: Auto Refresh  (Every 24 Hours )). 
The File->Save Error Data to File...  saves the data to a file from the last poll. Th
data saved in the file is in pure text format. The File->Exit  menu item closes all windows and
terminates the application.

Edit

The Edit->Reset Statistics  menu item sends an SNMP set to clear (1) statistics in the 
and (2) data presented on the screen. 

View

The View->Legend  reveals any hidden legend areas existing for all the screens. The legend
describes any notations used. For instance, the main window has a legend area which cont
expansions for the acronyms ES, SES, and so forth.

Navigate

See Figure 5-8.

Figure 5-8 Navigate->Several Menu Items Screen (6001)

The Navigate menu consists of several menu items to open other screens that are part of th
reports application.
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Error Totals (E1)

See Figure 5-9.

Figure 5-9 Twenty Four-Hour Error Totals Screen (6001)

This screen contains graphs for Current 24 Hour Totals , Recent 24 Hour Totals , 
and textual representation of 24 Hour totals and data collection periods in real time.

The Current 24 Hour totals and Recent 24 Hour totals are identical in content. Only the Curr
Hour totals are described here. The equivalent T1 screen does not have Recent 24 Hour Tot
buttons, representing the X-Axis an the graph, open up the screen containing the data of th
attributes spread over 24 hours in buckets of 15 minutes. This is the same as using the Nav
menu for the attribute. The graph contains two bars, one for Near End  and one for Far End . 
This is applicable for T-1 HDSL, E-1 HDSL, and E-1 interfaces. The screen for T1 interface 
one bar which represents Near End  data. 

The time data presented in the Collection Period area uses the mib object 
mp6001StatsLastInitialized  to extract the elapsed time and to convert it to real-time
Refer to Description of Mib Objects and Terms for more details.
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Errors Summary (E1)

See Figure 5-10.

Figure 5-10 Errors Summary Screen (6001)

This screen represents all the statistical data that is possible for an LIU in textual form. The Y
is fixed and the statistical attributes take place. The X-Axis is changeable to view the time sc
interval scale, or both. An important point to be noted here is that the graph has 24 hours w
data represented, but some of the intervals add up to be the current 24 hour totals with the rem
intervals partially adding up to the recent 24 hour totals. This is applicable for E1, T1-HDSL
E1-HDSL interfaces. If data has been collected for less than 24 hours, the time/intervals on
Axis of the graph are grayed-out for the unavailable period.

At the bottom of the screen the textual information presented about collection period indicat
spread of the current 24 hours and recent 24 hours for individual statistical attributes over 15 m
intervals. The time indicates the real-time determined from mp6001StatsLastInitialized  
and workstation time during which data has been collected. Also indicated is the intervals w
correspond to the duration given above. This paragraph does not apply to T1 interfaces beca
the collected data always represent the current 24 hour totals.

Looking at the current 24-hour error totals for the LIU A , you see shown along six vertical axes i
intervals of seconds are total errors represented by vertical bar graphs that have occurred f
of six error events, designated as KEY: ES (Errored Seconds), SES (Severely Errored Seconds), 
BES (Bursty Errored Seconds), UAS (Unavailable Seconds), BPV (Bipolar Violations), and LOF 
(Loss of Frame Count). There are three different options or intervals, 0 to 65000 , 32500 , or 
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t 15-
to 16250 , on the vertical scale. Select one of them by clicking on one of the items in Set 
Vertical Scale . This is an example of the 0 to 65000  interval for reporting LIU A total 
errors in the current 24-hour period.

• Error Reports Window Menus

The Error Reports window has File , Edit , and Navigate  menus in its menu bar.

See Figure 5-11. The File  menu consists of Reset Statistics  and Exit  selections. The 
Clear Statistics  selection reads the statistics from the LIU  A or LIU  B and updates the 
display to reflect changes that have occurred since the window was opened or since the last Clear 
Statistics

.

Figure 5-11 Error Report File Selection Screens (6001)

The Exit  selection dismisses the Error Reports window.

See Figure 5-12. The Navigate  menu contains eight detailed Error Reports displays:

 

Figure 5-12 Error Report Navigate Selection Screen (6001)

There are six graphic and two textual screens, detailing information about errors collected a
minute intervals during the recent four hours.

• Errored Seconds (ES) Report

Reset Reset
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An Errored Second (ES) is defined as a second with at least one CRC error event. For this sc
you have a Set Vertical Scale  where you have three vertical scales of seconds interval
choose from. The screen shows also numeric displays for the current 24-hour period. This s
graphically shows the number of errored seconds that have taken place in one of six four-ho
periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, eac
displaying bars for the Metroplex 6001 Platform card application. The graph bars are identifi
0 through 16  and Avg: 

0 is the number of errored seconds that have occurred so far in the current, incomplet
minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of errors occurred in the latest 4-hour period.

1 through 16  spans the four hour-period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of errored seconds against a selectab
of 0 to 900 , 450 , or 225 ; click on a preferred vertical scale in Set Vertical Scale  above 
the bar graph. The unit lets you view four hours of error reports, while non-applicable interva
grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window. 

• Severely Errored Seconds (SES) Report

Severely Errored Second (SES) is defined as a second with 7 or more CRC error events, or on
more Out of Frames. The screen shows the Severely Errored Seconds (SES) screen. In Set 
Vertical Scale  you have three vertical scales of seconds intervals to choose from. The s
shows also numeric displays for the current 24-hour period. This screen graphically shows t
number of severely errored seconds that have taken place in one of six four-hours periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, eac
displaying bars for the Metroplex 6001 Platform card application. The graph bars are identifi
0 through 16  and Avg: 

0 is the number of severely errored seconds that have occurred so far in the current, i
plete 15-minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of errors occurred in the latest 4-hour period.

1 through 16  spans the four-hour period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of severely errored seconds against 
selectable scale of 0 to 900 , 450 , or 225 ; click on a preferred vertical scale in Set Vertical 
Scale  above the bar graph. The unit lets you view four hours of error reports, while non-appli
intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window.

• Background Block Errors (E1)

Background Block Errors  are parameters (in the background) indicating whethe
CRC block errors were detected in a preceding frame in the opposite direction of trans
sion.

See Figure 5-13. 
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Figure 5-13 Background Block Errors (E1) Screen (6001)

This screen is the basic screen for all individual statistical attributes like ES, SES, etc. The o
variation between screens is the title of the screen. Like all other graphs, the Y-Axis scale 
dynamically changes depending on the maximum value of a certain interval. The X-Axis opt
button on the upper right hand corner allows the user to view the X-Axis as a time scale or in
scale or both. The graph contains two bars to represent Near End and Far End. There is only
when the interface type is T1. The screens for T1-HDSL and E1-HDSL interfaces are identi
E1 interface. If data has been collected for less than 24 hours, the time/intervals on the X-A
the graph are grayed out for the unavailable period.

• Bursty Errored Seconds (BES) Report

Bursty Errored Second (BES) is defined as a second with more than one, but less than 320 CR
error events. The screen shows the Bursty Errored Seconds (BES) screen. In Set Vertical 
Scale  you have three vertical scales of seconds intervals to choose from. The screen show
numeric displays for the current 24-hour period. This screen graphically shows the number of 
errored seconds that have taken place in one of six four-hours periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, eac
displaying bars for the Metroplex 6001 Platform card application. The graph bars are identifi
0 through 16  and Avg: 

0 is the number of bursty errored seconds that have occurred so far in the current, inco
15-minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of errors occurred in the latest 4-hour period.
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1 through 16  spans the four-hour period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of bursty errored seconds against a se
scale of 0 to 900 , 450 , or 225 ; click on a preferred vertical scale in Set Vertical Scale  
above the bar graph. The unit lets you view four hours of error reports, while non-applicable
intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window. 

• Unavailable Errored Seconds (UAS) Report

Unavailable Errored Seconds (UAS) is defined as a count of one-second intervals when ser
not available. Service-not-available means 10 or more consecutive SESs. The screen show
Unavailable Errored Seconds (UAS) screen. In Set Vertical Scale  you have three vertical 
scales of seconds intervals to choose from. The screen shows also numeric displays for the
24-hour period. This screen graphically shows the number of unavailable seconds that have
place in one of six four-hours periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, eac
displaying bars for the Metroplex 6001 Platform card application. The graph bars are identifi
0 through 16  and Avg: 

0 is the number of unavailable seconds that have occurred so far in the current, incom
15-minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of errors occurred in the latest 4-hour period.

1 through 16  spans the four-hour period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of unavailable seconds against a sele
scale of 0 to 900 , 450 , or 225 ; click on a preferred vertical scale in Set Vertical Scale  
above the bar graph. The unit lets you view four hours of error reports, while non-applicable
intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window. 

• Line Code Violations

Line Code Violations (LCV) specifies the T1 or E1 near-end line code violations performance al
measurement interval. It also specifies the E1 near-end line code violations performance ala
mask. N/A  is displayed for an HDSL LIU.

The front panel (Platform 6001) indicator reflects the current status of LCV error events. 

The screen shows the Line Code Violations (LCV) screen. In Set Vertical Scale  you have 
three vertical scales of seconds intervals to choose from. The screen shows also numeric d
for the current 24-hour period. This screen graphically shows the number of line code violat
that have taken place in one of six four-hours periods.

Time intervals on the horizontal axis of the bar graph display are: 1 Second , 10 Seconds , 30 
Seconds , 1 Minute , 15 Minutes , 1 Hour , 24 Hours , and No Limit .

The vertical axis of the bar graph displays the number of line code violations seconds again
selectable scale of 0 to 65000 , 32500 , or 16250 ; click on a preferred vertical scale in Set 
Vertical Scale  above the bar graph. The unit lets you view four hours of line code viola
reports, while non-applicable intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window. 
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• Bipolar Violations Report

Bipolar Violations (BPV) is defined as an alarm event occurring when the signal the DSU rece
from the Metroplex 6001 Platform card does not alternate between signal levels as required
Alternate Mark Inversion (AMI) or Bipolar with 8 Zero Substitution (B8ZS) data encoding. 

The front panel (Platform 6001) indicator reflects the current status of BPV error events. 

The screen shows the Bipolar Violations (BPV) screen. In Set Vertical Scale  you have three 
vertical scales of seconds intervals to choose from. The screen shows also numeric displays
current 24-hour period. This screen graphically shows the number of bipolar violations that 
taken place in one of six four-hours periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars, eac
displaying bars for the Metroplex 6001 Platform card application. The graph bars are identifi
0 through 16  and Avg: 

0 is the number of bipolar violations that have occurred so far in the current, incomple
minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of bipolar violations occurred in the latest 4-hour period.

1 through 16  spans the four-hour period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of bipolar violations seconds against 
selectable scale of 0 to 65000 , 32500 , or 16250 ; click on a preferred vertical scale in Set 
Vertical Scale  above the bar graph. The unit lets you view four hours of bipolar violatio
reports, while non-applicable intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window. 

• Loss of Frame Count (LOFC) Report

Loss of Frame Count (LOFC) is the accumulation of the number of times a Loss of Frame is
declared. For this screen, in Set Vertical Scale  you have three vertical scales of second
intervals to choose from. The screen shows also numeric displays for the current 24-hour p
This screen graphically shows the number of loss of frame errors that have taken place in on
four-hours periods.

Time intervals are the horizontal axis of the bar graph display. There are 18 graph bars
displaying bars for the Metroplex 6001 Platform card application. The graph bars are i
fied as 0 through 16  and Avg : 

0 is the number of loss of frames that have occurred so far in the current, incomplete 1
minute interval. 

Selecting a 4-hour period allows the user to choose a four-hour period of the current 24 
0 to 4 selects the number of errors occurred in the latest 4-hour period.

1 through 16  spans the four-hour period selected, divided into 15-minute intervals. 

Avg is the mean for the 16 values of completed intervals. 

The vertical axis of the bar graph displays the number of loss of frames against a selectable s
0 to 65000 , 32500 , or 16250 ; click on a preferred vertical scale in Set Vertical Scale  
above the bar graph. The unit lets you view four hours of error reports, while non-applicable
intervals are grayed-out.

When you are finished with this screen, click on the OK button to dismiss the window.

• Error Report (Text)
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The Error Events display screen is the text version of the Error Reports graphic representat
tabulates data on the six types of error events that have occurred. 

The screen displays Total Error Events over the current 24-hour period (without current interval). 
The display headed Current Error Events: Current 15 Minute Interval  shows the error 
events accumulated thus far in the uncompleted current interval. For the 15-minute bounda
accumulation is transferred to the Current 24 Hours  count and a new current interval begins

The Cumulative Error Events  display at the bottom of the screen gives you a detailed vi
of error events that have happened over the most recent 24 hours. Each interval correspond
minute durations. The Number Of Valid Intervals  indicates the number of intervals, 
which could be 96 or less, completed by the unit in the past 24 hours.

Click on the OK button to dismiss the window when are finished with it. 
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Configuration

Metroplex 6000 Configuration Window Fields

The main Metroplex 6000 Configuration window contains three text input fields and eight dis
fields. The information you store in this window is simply text to identify the Metroplex 6000 
the shelf it controls, and to provide an operator at a TEAM management workstation with the
of a person on-site where the equipment is located to contact if need arises.

 Three text input fields in the Metroplex 6000 Configuration window are labeled System Name , 
System Location , and System Contact . The application does not enforce any restriction
on the text you can insert in these fields, but we recommend that you fill in appropriate inform

See Figure 5-14. Selection from the main menu bar or the front panel select switch. From the 
Platform Card Configuration Menu screen, you can select Channel Configurations for chann

Figure 5-14 Configuration Menu Screen (6001)

The Main Configuration window displays the following read-only items:

Name: User-configured name for the LIU 

Sytem Name: Identifier assigned to the Metroplex 6000 Platform card and its shelf

Sytem Location: Address of the site where the Metroplex 6000 Platform card and its shelf a
located

Sytem Contact: Name and telephone number of the on-site person responsible for care an
maintenance of equipment in the shelf administered by the Metroplex 6000
Platform card

Sytem Description: Metroplex 6000 Manager

Sytem Uptime: Time elapsed since the last time a reset was performed or power was cycle
the Metroplex 6000
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The following steps describe how to use the configuration application, and illustrate the func
of the 6001 Configuration window menus. 

1. Access the 6001 Configuration window, either from the submap menu bar or from the 
Front Panel display. The application reads the current 6001 configuration from the LIU
when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the LIU continues to operate using its un
changed current configuration. 

The Refresh  selection on the Main window File  menu causes the application to read th
current configuration from the LIU. All changes to all configuration windows that have 
previously been saved to the LIU or a template are lost when you select Refresh . 

2. To edit the current configuration of the LIU, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 

3. Click on the Navigate  button to display a menu of the 6001 configuration windows, an
select the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. Click the mo
on the value you select. When you change the value or setting of an option, the applic
displays the option name and the new value in white, rather than black, type. They rem
white until you either save the changes or a template by means of the Main window File  
menu, or restore the option to its last stored value or setting. 

You can discard changes to a 6001 configuration window and return all its fields to the
stored values in two ways:

Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a 6001 configuration window without losing changes by clicking on eithe
OK button or the pushpin  icon , which is located in the upper left corner of the window

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The 6001 Main Configur
window remains on-screen throughout the configuration process. 

Status: On line or off line

Firmware Revision: Revision level of the LIU operating code

Hardware Revision: Revision level of the hardware on the Metroplex 6000 Platform Card

6000 MIB Version: Revision level of the MIB files that enable Team 6000 control 

6001 MIB Version: Revision level of the MIB files that enable 6001 card control

GDC-CMN MIB Version: Revision level of the Common MIB files installed in the Metroplex 6000

Name: User-configured name for the LIU 
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5. When you have accessed all the configuration windows that you need to and made al
your changes, click on the File  menu button of the 6001 Main Configuration window. 
From that menu you can select Save  to  Unit  to save the new configuration in the LIU, o
select Save  to  Template  to save it as a template in the workstation. 

When you select Save  to  Unit , the changed configuration becomes the current configu
tion for the LIU. 

When you select Save  to  Template , a window appears containing a list of existing template
and a field for entering a new template name. You can select an existing template to be over
with the new configuration, or enter a name to create a new template. A stored template is av
to be loaded by the application and then saved, with or without further modification, to any T
6000 LIU. 

The main Metroplex 6000 Configuration window is the first to appear when you launch the 
application. It contains three configurable fields for system information and eight read-only fi
This screen lets you access the other ten screens in the Metroplex 6000 Configuration appli
Metroplex 6000 Options , Trap Options , IP Routing Options , Community 
Name Options , and Miscellaneous Metroplex 6000 Options . 

The Metroplex 6000 Configuration window has two pull down menus: File  and Navigate . The 
contents of the menus appear below.

 

Menus Menu Selections

File

Refresh

Save to Unit

Load Template... dialog window

Save to Template (*)... dialog window

Compare to Template... dialog window

Exit

Navigate

Platform Options... dialog window

Liu A Options... dialog window

Liu B Options... dialog window

Power Supply Alarms Reported... dialog window

LIU A Alarms Reported... dialog window

LIU B Alarms Reported... dialog window

Alarm Dial-Out Options... dialog window

Trap Options... dialog window
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Menu Selection Definitions

IP Routing Options... dialog window

Community Name Options... dialog window

All Screens...

* Displays needed when there are pending changes, unneeded when there are no
ing changes.

File Menu Selection Definition

Refresh This selection on the main window File  menu causes the application to read the 
current configuration from the LIU. All changes to all configuration windows that
have not previously been saved to the LIU or a template are lost when you sele
Refresh .

Save to Unit Sends the displayed configuration to the Metroplex 6000. If the configuration h
changed, a pop-up suggests that this new configuration be saved. A footer mes
indicates that configuration categories are being downloaded.

Load Template Opens a window listing all Agent Configuration templates stored on the worksta
from which you may select a template file to display.

Save to Template Stores the displayed configuration, with any changes you have made, under th
rently selected template file name.

Compare to Template Compares the displayed configuration to a selected template file.

Exit Dismisses the window.

*Metroplex 6000 Configuration application only (not applicable to Template application)

Navigate Menu Selection Opens window for setting:

Platform Options Options that control the configuration of the platform card.

LIU A Options Options that control the configuration of the LIU A.

LIU B Options Options that control the configuration of the LIU B.

Power Supply Alarms Reported Displays the Power Supply Alarms Reported window. This selection is ava
only when the MIB object is mp6000ShelfType , a wall-mount enclosure. 

LIU A Alarms Reported Displays the MEtroplex 6001 LIU Alarms Reported window that is appropria
for the type of LIU (LIU A ) as indicated in the MIB object 
mp6001InterfaceType .

Menus Menu Selections
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See Figure 5-15 and refer to Table 5-6. The Configuration screen is used to configure System 
Options  and shows you both the system options Configuration and the Drop & Insert 
Timeslot Configuration  screen selections.

LIU B Alarms Reported Displays the MEtroplex 6001 LIU Alarms Reported window that is appropria
for the type of LIU (LIU B ) as indicated in the MIB object 
mp6001InterfaceType .

Alarm Dial-Out Options Displays the Metroplex 6001 Alarm Dial-Out Options Screen.

Trap Options Displays Trap Options and Trap Address Options. 

IP Routing Options Displays IP Routing Options.

Community Name Options Displays Community Names Options.

All Screens Opens all Metroplex 6001 Configuration screens simultaneously.

Navigate Menu Selection Opens window for setting:
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 5-29



Platform Card Configuration
Figure 5-15 System Options/Drop & Insert Timeslot Screen (6001)
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Table 5-6 System Selections and Messages (6001)

Field Selection Description

LIU Interface 
Mode 

Network Link , Diverse 
Link, Drop and Insert

Specifies the operation of the LIUs. 

Network Link is used when one or both LIUs are connected to the n
work independently.

Diverse Link allows LIU B to backup LIU A. When a failure occurs 
on LIU A, LIU B is instructed to take over. This selection is not avail
able if channels are assigned to LIU B or if LIU B is not present.

Drop  & Insert  is used when timeslots on LIU A are redirected 
through LIU B and are therefore not available for channel cards. Th
selection is disabled (grayed-out) when CAS for LIU A is off and 
CAS for LIU B is on.

Transmit Timing Network A , Internal Specifies the transmit timing source. 

Internal is used when the Metroplex 6000 provides the timing to th
network.

Network A is used when the network connected to LIU A provides
the timing.

Backup Transmit 
Timing

Network B, Internal Specifies the backup transmit timing source. This is used when an
LIU A failure occurs. The available timing options are dependent o
Transmit Timing selection.

Internal is used when the Metroplex 6000 provides the timing in th
network.
Network B is used when the network connected to LIU B provides th
timing.

Passthru Start 
Timeslot 

Off  and 1-31 Specifies the start timeslot for Drop and Insert.

Type 0 or Off.

Passthru Stop 
Timeslot 

Off  and 1-31 Specifies the stop timeslot for Drop and Insert. This timeslot must 
equal to or greater than start timeslot.

’0’ (zero) can be used to specify Off.

Drop & Insert 
Channel Type

Clear, Signaling, and Un-
available 

Select Signaling Channel for voice channels or Switched 56 data 
channels which require robbed-bit signaling. Sig  Chan selections 
are grayed-out if CAS selection is off for either LIU. Setting any 
channel to Sig  Chan disables the Off -state for CAS on both LIUs. 
Selecting Clear Channel (Clr  Chan) passes all eight bits of the 
timeslot.

Ch 16  has the menu cell CAS Sig  when the interface type is E1. This 
selection is enabled only when CAS is on for both LIUs. When CAS
is on, Ch 16  is disabled (grayed-out) and forced to CAS Sig .

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select sa
first. If you select Cancel , the screen becomes active and you can
then select the save option. If you select OK, the screen is exited and 
the configuration changes are lost.

Note: Selections in bold print are the default positions.
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T1 LIU Options (CSU or DSX1)

See Figure 5-16, which features a CSU interface type, and refer to Table 5-7. There are two types 
of screens: LIU A and LIU B, each with T1 LIU options, CSU or DSX1. Screen changes depe
the option cards installed.

Figure 5-16 T1 LIU Options (CSU or DSX1) Screen (6001)
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Table 5-7 T1 LIU Options Selections and Messages (6001) 

Field Selection Description

Interface Type
(read only)

CSU, DSX-1, Un-
known

Specifies the Interface Type read from card. Unknown indicates Platfor
card does not recognize Interface Type. Check the firmware revision.

Line Code B8ZS, AMI This sets the line code for the equipment side to AMI (Alternate Mark In
version, with no bipolar violations) or B8ZS (Bipolar with 8 Zero Substi
tution, with bipolar violations). This selection must match the line code
used on your T1 line.

Line Build-Out 0.0dB, -7.5dB, -
15.0dB

Line Build-Out - Applying to CSU only, this sets the Line Build-Out to 
one of the following attenuation levels: 0 dB, -7.5 dB, or -15 dB. Selec
the Line Build-Out to compensate for the cable loss to the first T1 repea
(e.g. 0dB for a high cable loss).

This selection is disabled (grayed-out) when Interface  Type  is 
DSX1.

Pre-
Equalization

Intervals in ft:
0 - 133
133 - 266
266 - 399
399 - 533
533 - 655

Pre-equalization applies to the DSX1 only and not to the CSU where y
would see this field grayed-out.

Frame Type D4, ESF This sets the frame format to D4 (D4 Superframe Format) or ESF (Ex-
tended Superframe Format). When this selection is D4, ESF mode is d
abled (grayed-out).

ESF Mode TR54016, None This sets Central Office compatibility to ANSI or TR54016. These publ
cations define, in part, how signal quality or performance measuremen
are determined, transmitted, and responded to. The ANSI mode suppo
Bellcore Scheduled Performance Report Messages (PRMs) and Unsch
uled Messages, messages initiated by the Telco and contained in the D
Link sub-channel provided in ESF framing. The TR54016 mode suppor
their Telemetry Asynchronous Block Serial Protocol (TABS), a mainte
nance message protocol initiated by the Telco and contained in the Da
Link sub-channel provided in ESF framing.

The ESF mode is grayed-out or disabled when Frame  Type  is D4.

Hardware Rev
(read-only)

--, A-,..., AA,... ZZ Current hardware version. 

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select save f
If you select Cancel , the screen becomes active and you can then sele
the save option. If you select OK, the screen is exited and the configuration
changes are lost.

Notes: 1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays
screen an SNMP general error.             2. Defaults in bold.
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E1 LIU Options

See Figure 5-17 and refer to Table 5-8. The screen below is shown when
Navigate->LIU A/B Options  is selected and the Interface  Type  is E1. This screen 
allows you to configure a particular LIU.

Figure 5-17 E1 LIU Options Screen (6001)
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HDSL E1 LIU Options

See Figure 5-18 and refer to Table 5-9. The screen below is shown when
Navigate->LIU A/B Options  is selected and the Interface  Type  is HDSL E1. This 
screen allows you to configure a particular LIU.

Table 5-8 E1 LIU Configuration Selections and Messages (6001) 

Field Selection Description

Interface Type
(read only)

E1 Specifies that the Interface Type read from card is E1. 

CRC4 On or Off When Frame Type is D4, ESF Mode is disabled (grayed-out).

CAS On or Off This selection is disabled (grayed-out) if any channel card using a Timeslot
quires channel signalling. Off  disables (grays-out) all timeslot selections for all
voice channels, except when:

The interface type of a channel is a 4-Wire Transmit Only .

All Timeslot selections for any Flexi-Data channel has a data rate of Switched 
56 kbps .

Sig Chan  and Drop & Insert Timeslot  are selected.

Off  is disabled, if any of the following statements are true:

 (1)  A timeslot is assigned to a voice channel.

 (2)  The Digital Service  for a Flexi-Data channel is set to Switched 
56 kbps .

 (3)  Drop & Insert Timeslot  is selected to Sig Chan .

Selection On is grayed-out if Timeslot 16  is assigned on the Drop & Insert 
portion of the platform options window. Conversely, Timeslot 16 is grayed-ou
if the selection is on.

Impedance
(read-only)

75 Ohms,
120 Ohms, or 
Jumper Error

The impedance selected by the hardware jumper.

Hardware Rev
(read-only)

--, A-,..., 
AA,... ZZ 

Current hardware version. 

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select save first. If 
select Cancel , the screen becomes active and you can then select the save
tion. If you select OK, the screen is exited and the configuration changes are lo

Notes: 1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays
screen an SNMP general error.             2. Defaults in bold.
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Figure 5-18 HDSL E1 Configuration Screen (6001)

Table 5-9 HDSL E1 Configuration Selections and Messages (6001) 

Interface Type
(read only)

HDSL E1 Specifies that the Interface Type read from card is HDSL E1. 

CRC4 Off or On This turns CRC-4 Multiframe On or Off.

CAS On or Off This selection is on if any channel card using a Timeslot requires channel s
nalling. Off  disables (grays-out) all timeslot selections for all voice channels
except when:

The interface type of a channel is a 4-Wire Transmit Only .

All Timeslot selections for any Flexi-Data channel has a data rate of Switched 
56 kbps .

Sig Chan  and Drop & Insert Timeslot  are selected.

If a Timeslot is assigned to a voice channel, or the Digital Service  for a 
Flexi-Data channel is set to Switched 56 kbps , or Drop & Insert 
Timeslot  is selected to Sig Chan , then Off  is disabled.

Selection On is grayed-out if Timeslot 16  is assigned on the Drop & Insert 
portion of the platform options window and conversely, Timeslot 16 is grayed
the selection is on.

Terminating Unit 
Type

Network or 
Line

This is used only for HDSL LIUs, in all other cases the value will always be N/A

When a HDSL LIU is specified, it can be configured as a NTU (Network Ter
minating Unit) or LTU (Line Terminating Unit). 

In most cases, a HDSL LIU on the Metroplex 6000 will be configured as a NT
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HDSL T1 LIU Options

See Figure 5-19 and refer to Table 5-10. The screen below is shown when
Navigate->LIU A/B Options  is selected and the Interface  Type  is HDSL T1. This 
screen allows you to configure a particular LIU.

Figure 5-19 HDSL T1 Configuration Screen (6001)

Number of Loops 
Enabled

1 or 2 This selection is disabled (grayed-out) when any of the Timeslots 13 through
on the Drop and Insert portion of the platform options window is selected for 
clusion. Conversely, these same timeslot selections are disabled (grayed-ou
the number of loops enabled is 1.

Starting Timeslot Disabled, 1, 
2,..., 14

Specifies the stop timeslot for drop and insert. By choosing Disabled,  this 
selection becomes disabled (grayed-out) if you have two loops enabled. 

Hardware Rev
(read-only)

--, A-,..., 
AA,... ZZ 

Current hardware version. 

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select save first. If 
select Cancel , the screen becomes active and you can then select the save
tion. If you select OK, the screen is exited and the configuration changes are lo

Notes: 1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays
screen an SNMP general error.             2. Defaults are in bold.

Table 5-9 HDSL E1 Configuration Selections and Messages (6001)  (Continued)

Interface Type
(read only)

HDSL E1 Specifies that the Interface Type read from card is HDSL E1. 
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Power Supply Alarms Reported

See Figure 5-20. This screen is shown when you choose Configuration/Navigate-
>Power Supply Alarms Reported  on the Metroplex 6001 Configuration main window.
This selections is available only when the MIB object is mp6000ShelfType  is a wall-mount 
enclosure.

Table 5-10 HDSL T1 Configuration Selections and Messages (6001) 

Interface Type
(read only)

HDSL T1 Specifies that the Interface Type read from card is HDSL T1.

Frame Type D4 or ESF When D4 is selected, ESF mode is disabled (grayed-out).

ESF Mode None or 
TR54016

When frame type is D4, this mode is disabled (grayed-out).

Terminating Unit 
Type

Network or 
Line

This is used only for HDSL LIUs, in all other cases the value will always be N/A

When a HDSL LIU is specified, it can be configured as a NTU (Network Ter
minating Unit) or LTU (Line Terminating Unit). 

In most cases, a HDSL LIU on the Metroplex 6000 will be configured as a NT

Number of Loops 
Enabled

1 or 2 This selection is disabled (grayed-out) when any of the Timeslots 13 through
on the Drop and Insert portion of the platform options window is selected for 
clusion. Conversely, these same timeslot selections are disabled (grayed-ou
the number of loops enabled is 1.

Starting Timeslot Disabled, 1, 
2,..., 13

Specifies the stop timeslot for drop and insert. By choosing Disabled,  this 
selection becomes disabled (grayed-out) if you have two loops enabled. 

Hardware Rev
(read-only)

--, A-,..., 
AA,... ZZ 

Current hardware version. 

Messages

Application Has Pending Edits (OK/
Cancel)

Displayed if you made a change on the screen but did not select save first. If 
select Cancel , the screen becomes active and you can then select the save
tion. If you select OK, the screen is exited and the configuration changes are lo

Notes: 1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays
screen an SNMP general error.             2. Defaults are in bold.
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T1 LIU Alarms Reported (CSU or DSX1)

See Figure 5-21 and refer to Table 5-11. You see this screen for alarms reported when you cho
Configuration/Navigate->LIU A/B  Alarms Reported  and MIB object 
mp6001InterfaceType  is CSU or DSX1. This screen lets you configure the LIU alarms 
applicable to a particular LIU.
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Figure 5-21 T1 LIU Alarms Reported (CSU or DSX1) Screen (6001)

The above screen displays alarms as reported or masked (Refer to local management man
specific masking and reporting descriptions on each field in Table 5-11). Alarms are always 
displayed on monitor screens regardless of their reported/masked configuration. Performan
alarms such as Errored Seconds , for example, pertaining to the T1 LIU require additional 
configuration of thresholds and measurement interval windows. A field is unmasked when th
diamond glyph  is recessed.
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Table 5-11 T1 LIU Alarms Reported (CSU or DSX1) (6001) 

Field Network Alarm Description

Name
(read-only)

Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the CSU or DSX1 slot number, and the user-configured device name

Errored
Seconds (ES)

Enables Threshold  and Window.

ES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Errored Seconds alarms are not allowed.

ES
Window

Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Errored Seconds alarms are not allowed.

Severely
Errored
Seconds 
(SES)

Allowing this alarm enables SES Threshold  and SES Window .

SES Thresh-
old

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Severely Errored Seconds alarms are not allowed.

SES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Severely Errored Seconds alarms are not allowed.

Unavailable 
Seconds 
(UAS)

Allowing this alarm enables UAS Threshold  and UAS Window .

UAS
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Unavailable Seconds alarms are not allowed.

UAS Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Unavailable Seconds alarms are not allowed.

Bursty
Errored
Seconds 
(BES)

Allowing this alarm enables BES Threshold  and BES Window .

BES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Bursty Errored Seconds alarms are not allowed.

BES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Bursty Errored Seconds alarms are not allowed.

CRC Allowing this alarm enables CRC Threshold  and CRC Window.

CRC
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if CRC alarms are not allowed.

CRC
Window

Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if CRC alarms are not allowed.

Bipolar
Violations

Allowing this alarm enables Bipolar Violations Threshold  and
Bipolar Violations Window .
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E1 LIU Alarms Reported

See Figure 5-22 and refer to Table 5-12. You see this screen for alarms reported when you cho
Configuration/Navigate->LIU A/B  Alarms Reported  and MIB object 
mp6001InterfaceType  is E1. This screen lets you configure the LIU alarms applicable to
particular LIU.

CRC
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Bipolar Violations alarms are not allowed.

CRC
Window

Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Bipolar Violations alarms are not allowed.

Loss of
Signal

LOS (Loss of Signal) is detected.

Out of Frame OOF (Out of Frame) is detected as defined in TR 62411.

All Ones 
Signal

AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm 
Indication

RAI (Remote Alarm Indication) is being received from the network.

Action Buttons (top)

Report All Selects all alarms for reporting.

Report None Deselects all alarms with no alarms reported.

Action Buttons (bottom)

OK Dismisses the window with the edits retained. This is the same action as the pin-pull.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset, dismissing the screen.

Table 5-11 T1 LIU Alarms Reported (CSU or DSX1) (6001)  (Continued)

Field Network Alarm Description
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Figure 5-22 E1 LIU Alarms Reported Screen (6001)

The above screen displays alarms as reported or masked (Refer to local management man
specific masking and reporting descriptions on each field in Table 5-12). Alarms are always 
displayed on monitor screens regardless of their reported/masked configuration. Performan
alarms such as Errored Seconds , for example, pertaining to the T1 LIU require additional 
configuration of thresholds and measurement interval windows. A field is unmasked when th
diamond glyph  is recessed.
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Table 5-12 E1 LIU Alarms Reported (6001)

Field Network Alarm Description

Name
(read-only)

Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the CSU or DSX1 slot number, and the user-configured device name

Network Near End

Line Code
Violation

Allowing this alarm enables LCV Threshold  and LCV Window .

LCV
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Line Code Violation alarms are not allowed.

LCV
Window

Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Line Code Violation alarms are not allowed.

Errored
Seconds (ES)

Allowing this alarm enables ES Threshold  and ES Window.

ES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Errored Seconds alarms are not allowed.

ES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Errored Seconds alarms are not allowed.

Severely
Errored
Seconds 
(SES)

Allowing this alarm enables SES Threshold  and SES Window .

SES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Severely Errored Seconds alarms are not allowed.

SES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Severely Errored Seconds alarms are not allowed.

Unavailable 
Seconds 
(UAS)

Allowing this alarm enables UAS Threshold  and UAS Window .

UAS
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Unavailable Seconds alarms are not allowed.

UAS Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Unavailable Seconds alarms are not allowed.

Background 
Block Errors 
(BBE)

Allowing this alarm enables BBE Threshold  and BBE Window .

BBE
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Background Block Errors alarms are not allowed.

BBE Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Background Block Errors alarms are not allowed.
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Network Far End

Errored
Seconds (ES)

Allowing this alarm enables ES Threshold  and ES Window.

ES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Errored Seconds alarms are not allowed.

ES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Errored Seconds alarms are not allowed.

Severely
Errored
Seconds 
(SES)

Allowing this alarm enables SES Threshold  and SES Window .

SES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Severely Errored Seconds alarms are not allowed.

SES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Severely Errored Seconds alarms are not allowed.

Unavailable 
Seconds 
(UAS)

Allowing this alarm enables UAS Threshold  and UAS Window .

UAS
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Unavailable Seconds alarms are not allowed.

UAS Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Unavailable Seconds alarms are not allowed.

Background 
Block Errors 
(BBE)

Allowing this alarm enables BBE Threshold  and BBE Window .

BBE Thresh-
old

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Background Block Errors alarms are not allowed.

BBE Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Background Block Errors alarms are not allowed.

Network

Out of Frame OOF (Out of Frame) is detected as defined in TR 62411.

Loss of
Signal

Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

All Ones 
Signal

AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm 
Indication

RAI (Remote Alarm Indication) is being received from the network, that is, it specifies the agg
gate remote alarm indication alarm mask.

Timeslot 16

Out of Frame OOF (Out of Frame) is detected.

Table 5-12 E1 LIU Alarms Reported (6001) (Continued)

Field Network Alarm Description
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HDSL E1 LIU Alarms Reported

See Figure 5-23 and refer to Table 5-13. This screen shows you alarms reported when you cho
Configuration/Navigate->LIU A/B  Alarms Reported  and MIB object 
mp6001InterfaceType  is HDSL-E1. This screen lets you configure the LIU alarms applica
to a particular LIU.

The above screen displays alarms as reported or masked (Refer to local management man
specific masking and reporting descriptions on each field in Table 5-13). Alarms are always 
displayed on monitor screens regardless of their reported/masked configuration. Performan
alarms such as Errored Seconds , for example, pertaining to the T1 LIU require additional 
configuration of thresholds and measurement interval windows. A field is unmasked when th
diamond glyph  is recessed.

All Ones 
Signal

AIS (Alarm Indication Signal) is being received from the network.

Remote Alarm 
Indication

RAI (Remote Alarm Indication) is being received from the network.

Action Buttons (top)

Report All Selects all alarms for reporting.

Report None Deselects all alarms with no alarms reported.

Action Buttons (bottom)

OK Dismisses the window with the edits retained. This is the same action as the pin-pull.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset, dismissing the screen.

Table 5-12 E1 LIU Alarms Reported (6001) (Continued)

Field Network Alarm Description
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Table 5-13 HDSL E1 LIU Alarms Reported (6001) 

Field Network Alarm Description

Name
(read-only)

Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the CSU or DSX1 slot number, and the user-configured device name

Network Near End and Far End

Errored
Seconds (ES)

Allowing this alarm enables ES Threshold  and ES Window .

ES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Errored Seconds alarms are not allowed.

ES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Errored Seconds alarms are not allowed.

Severely
Errored
Seconds 
(SES)

Allowing this alarm enables SES Threshold  and SES Window .

SES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Severely Errored Seconds alarms are not allowed.

SES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Severely Errored Seconds alarms are not allowed.

Unavailable 
Seconds 
(UAS)

Allowing this alarm enables UAS Threshold  and UAS Window .

UAS
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Unavailable Seconds alarms are not allowed.

UAS Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Unavailable Seconds alarms are not allowed.

Background 
Block Errors 
(BBE)

Allowing this alarm enables BBE Threshold  and BBE Window .

BBE
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Background Block Errors alarms are not allowed.

BBE Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Background Block Errors alarms are not allowed.

Network Alarms

Out of Frame OOF (Out of Frame) is detected as defined in TR 62411.

Remote Alarm 
Indication

RAI (Remote Alarm Indication) is being received from the network, that is, it specifies the agg
gate remote alarm indication alarm mask.
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HDSL T1 LIU Alarms Reported

See Figure 5-24 and refer to Table 5-14. This screen shows you alarms reported when you cho
Configuration/Navigate->LIU A/B  Alarms Reported  and MIB object 
mp6001InterfaceType  is HDSL-T1. This screen lets you configure the LIU alarms applica
to a particular LIU.

The above screen displays alarms as reported or masked (Refer to local management man
specific masking and reporting descriptions on each field in Table 5-14). Alarms are always 
displayed on monitor screens regardless of their reported/masked configuration. Performan
alarms such as Errored Seconds , for example, pertaining to the T1 LIU require additional 
configuration of thresholds and measurement interval windows. A field is unmasked when th
diamond glyph  is recessed.

HDSL Alarms

Major Bit 
Error Rate 
(BER)

Allowing this alarm enables Major BER Threshold .

Major BER 
Threshold

Options are ->=10E-4, ->=10E-5, ->=10E-6, ->=10E-7, and ->=10E-8. This alarm is disabled
(grayed-out) if Major Bit Error Rate alarms are not allowed.

Minor Bit 
Error Rate 
(BER)

Allowing this alarm enables Minor BER Threshold .

Minor BER 
Threshold

Options are ->=10E-4, ->=10E-5, ->=10E-6, ->=10E-7, and ->=10E-8. This alarm is disabled
(grayed-out) if Minor Bit Error Rate alarms are not allowed.

Loss Of
Signal

Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

Loss Of Sync Advises you that there was no framing on the U-loop signal (or it has been lost) for the unit.

Remote Loss 
Of Signal

Problem with a remote unit. Either it is disabled or can not transmit or receive a signal.

Action Buttons (top)

Report All Selects all alarms for reporting.

Report None Deselects all alarms with no alarms reported.

Action Buttons (bottom)

OK Dismisses the window with the edits retained. This is the same action as the pin-pull.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset, dismissing the screen.

Table 5-13 HDSL E1 LIU Alarms Reported (6001)  (Continued)

Field Network Alarm Description
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Figure 5-24 HDSL T1 LIU Alarms Reported Screen (6001)

Table 5-14 HDSL T1 LIU Alarms Reported (6001) 

Field Network Alarm Description

Name
(read-only)

Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the HDSL T1 slot number, and the user-configured device name.

Network Near End and Far End

Errored
Seconds (ES)

Allowing this alarm enables ES Threshold  and ES Window .

ES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Errored Seconds alarms are not allowed.
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ES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Errored Seconds alarms are not allowed.

Severely
Errored
Seconds 
(SES)

Allowing this alarm enables SES Threshold  and SES Window .

SES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Severely Errored Seconds alarms are not allowed.

SES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Severely Errored Seconds alarms are not allowed.

Unavailable 
Seconds 
(UAS)

Allowing this alarm enables UAS Threshold  and UAS Window .

UAS
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Unavailable Seconds alarms are not allowed.

UAS Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Unavailable Seconds alarms are not allowed.

Bursty
Errored
Seconds 
(BES)

A bursty errored second (BES) is defined as a second with more than one, but less than 320 C
error events.

BES
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Background Block Errors alarms are not allowed.

BES Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Background Block Errors alarms are not allowed.

CRC Allowing this alarm enables CRC Threshold  and CRC Window.

CRC
Threshold

Options are - >= 1, - >= 3, - >= 10, - >= 100, - >= 1000, or - >= 10000. This alarm is disabled
(grayed-out) if Background Block Errors alarms are not allowed.

CRC Window Options are 1 sec, 10 sec, 30 sec, 1 min, 15 min, 1 hr, 24 hrs, and Infinite. This alarm is disa
(grayed-out) if Background Block Errors alarms are not allowed.

Out of Frame OOF (Out of Frame) is detected as defined in TR 62411.

Remote Alarm 
Indication

RAI (Remote Alarm Indication) is being received from the network, that is, it specifies the agg
gate remote alarm indication alarm mask.

HDSL Alarms

Major Bit 
Error Rate 
(BER)

Allowing this alarm enables Major BER Threshold .

Major BER 
Threshold

Options are ->=10E-4, ->=10E-5, ->=10E-6, ->=10E-7, and ->=10E-8. This alarm is disabled
(grayed-out) if Major Bit Error Rate alarms are not allowed.

Table 5-14 HDSL T1 LIU Alarms Reported (6001)  (Continued)

Field Network Alarm Description
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Alarm Dial-Out

See Figure 5-25 and refer to Table 5-15. This screen shown is available when you select 
Configuration/Navigate->Alarm Dial-Out Options . This screen allows you to 
configure the Alarm Dial-Out options and is available only when the 6001 MIB version is 3.00
higher.                                                                                     

Minor Bit 
Error Rate 
(BER)

Allowing this alarm enables Minor BER Threshold .

Minor BER 
Threshold

Options are ->=10E-4, ->=10E-5, ->=10E-6, ->=10E-7, and ->=10E-8. This alarm is disabled
(grayed-out) if Minor Bit Error Rate alarms are not allowed.

Loss Of
Signal

Red indicates LOS (Loss of Signal) is detected as defined in TR 62411.

Loss Of Sync
Word

Advises you that there was no framing on the U-loop signal (or it has been lost) for the unit.

Remote Loss 
Of Signal

Problem with a remote unit. Either it is disabled or can not transmit or receive a signal.

Action Buttons (top)

Report All Selects all alarms for reporting.

Report None Deselects all alarms with no alarms reported.

Action Buttons (bottom)

OK Dismisses the window with the edits retained. This is the same action as the pin-pull.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset, dismissing the screen.

Table 5-14 HDSL T1 LIU Alarms Reported (6001)  (Continued)

Field Network Alarm Description
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Figure 5-25 Alarm Dial-Out Screen (6001)

Table 5-15 Alarm Dial-Out (6001) 

Field Description

Name Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the CSU or DSX1 slot number, and the user-configured device name

Alarm Report 
Method

Options are Disable , ASCII , and SNMP. When Disable is selected all other options on the 
screen are disabled (grayed-out).

Disconnect
Timeout

Options are Immediate , 1 min , 2 min , ..., 15  min . When the Alarm Report Method is SNMP, 
the selection Immediate  is grayed-out (disabled). When the Alarm Report Method is Disable , 
this field is grayed-out.
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Modem Initialization Sequences

There are three (3) fields for entering the modem initialization sequences. Each field can con
to forty (40) characters. No validation is performed on these strings. These fields are disable
(grayed-out) when the mode of Alarm Report Method is in Disable .

Phone Numbers

There are three (3) fields for entering the phone numbers to call when alarms are to be repo
Each phone number can contain up to twenty-four (24) characters and are limited to:

0 thru 9, ‘(‘ , ‘)’ , - , <, and comma (, ). 

These fields are disabled (grayed-out) when the mode of Alarm Report Method is Disable .

Trap Options

See Figure 5-26.

Figure 5-26 Trap Options Screen (6001)

The Metroplex 6000 Trap Options configuration window lets you configure Trap destination 
options that the Metroplex 6000 can support as listed in the following paragraphs:

Action Buttons (bottom)

OK Dismisses the window with the edits retained. This is the same action as the pin-pull.

Reset Undoes pending edits since last File->Save to Unit  operation.

Cancel Same as Reset, dismissing the screen.

Table 5-15 Alarm Dial-Out (6001)  (Continued)

Field Description
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Traps are used in SNMP to send unsolicited information to a network manager. The informa
usually consists of events or alarms sent to the network manager for reports or special proc

The Trap Destination Table  in the Metroplex 6000 must be filled out if a network manag
is to receive Traps. The Metroplex 6000 can store up to five Trap destinations. Each Trap 
destination includes the IP Address and UDP port of the network manager and the Commun
Name.

• Traps Supported

Traps notify a network manager where there is an extraordinary event. The Metroplex 6000
supports these Traps.

The Cold Start  Trap is sent instead of the Link Up  Trap for the Ethernet interface. When 
another interface is brought up, a Link Up  Trap is sent.

Once the Metroplex 6000 is plugged into the shelf, Link UP  and Link Down  Traps may be sent 
to a network manager when an interface changes state. The Ethernet interface is never in th
state. The WAN interface, the DBU WAN interface, and the WAN interface of the CTRL port can 
change states as part of their normal operation.

The Metroplex 6000 supports these Metroplex 6000-specific Traps:

The Alarm Trap can be masked in the Node Table. You do this by either (1) turning off the a
scan to a network element or (2) through the Metroplex 6000, which toggles all alarm traps 
Control).

• Trap Generation Fields

Trap Sent when:

Cold Start First network interface is determined to be up.

Link UP Any other network interface comes up.

Link DOWN A network interface goes down.

Authentication Failure An SNMP command is received with an incorrect Community Name (can be masked
means of the Authentication Traps field).

Trap Sent when

Diversity Allows two network connections at the same time with one connection acting as a sp
to carry the data traffic of the other connection during line failure. Once this occurs, it h
to be manually switched back in Reset .

Alarm A network element detects a change in its alarm information.
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• Trap Destination Table

 The Trap Destination Table is arranged in three columns:

• Selected Entry Criteria

Adding a Trap Definition

To add a Trap definition:

1. In the All Traps field select Enable.

2. If you want the Authentication Failure Trap sent at the appropriate time, select Enable  in 
the Authentication Traps field. To prevent it from being sent, select Disable .

3. Click in the IP Address  field under Selected Entry Criteria  and type in the 
address of the intended destination.

4. Click in the UDP Port  field and type in the port number used by the SNMP manager. U
the default port number (162 ) unless the system administrator requires a different port.

5. Click in the Community Name  field and type in the Community Name associated with t
Trap destination.

6. Click on the Add button.

• Editing a Trap Definition

To edit a Trap definition:

1. Click on the Trap definition that you want to edit in the Trap Destination Table . 

2. Trap information appears in the corresponding Selected Entry Criteria  fields.

3. Perform the desired changes.

4. Click on the Replace  button.

• Deleting a Trap Definition

To delete a Trap definition:

1. Click on the Trap  definition that you want to delete in the Trap Destination Table. 

Traps Description

All Specifies if the Trap facility is enabled or disabled.

Authentication Masks or unmasks the Authentication Failure  Trap.

Trap Destination Description

IP Address Designates Address of the Trap destination.

UDP Port Specifies the port used by SNMP manager.

Community Name Specifies the Community Name associated with the Trap destination.
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2. Click on the Delete  button.

Metroplex 6001 IP Routing Options

See Figure 5-27. This window lets you configure IP Routing options that the Metroplex 6000 c
support as described in the pages that follow.

The window is divided into the IP Destination Table, which displays configured routing 
information, and the Selected Entry Criteria area, which contains the fields and buttons for 
configuring information.

 

Figure 5-27 IP Routing Options Configuration Window or Screen (6001)

• Fields

Field Description

Destination IP address to which the routing is being defined

Mask Used to divide IP Addresses into network identifier and host identifier. The bits set to 1 in the mask 
correspond to the network identifier. The entire network identifier portion must be contiguous 
to the left of the host identifier portion. Examples appear next. 

Note This mask is the filter used to establish the Routing Table . It must be set by experienced system 
administrative personnel.
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• SNMP IP Routing

In the IP group of MIB-II there is an IP Routing Table containing an entry for each route know
the Metroplex 6000. The main function of the table is to equate each out-going IP packet wi
route that provides the physical interface port. The routing table can be built via SNMP, if th
an existing IP connection to one of the ports, and is stored in volatile memory, but is lost if t
Metroplex 6000 is powered up again.

Adding an IP Route

To add an IP Route:

1. Click in the Destination  field and enter the appropriate address.

2. Click in the Mask field and enter the mask.

Field Description

Interface Indicates the routing interface type, i.e., GDC LAN Port, GDC WAN Port, LAN/WAN Port

Next Hop Specifies the IP Address of the next Metroplex 6000.

Route Type
Direct
Indirect

Selects one of the following routing types:
Signifies that the target device is on the same segment.
Signifies that the target device is not on the same segment.

Some valid subnet masks are:

255.0.0.0 Standard Class A network mask
255.128.0.0 Class A network, 2 subnetworks
255.192.0.0 Class A network, 4 subnetworks
255.224.0.0 Class A network, 8 subnetworks

255.255.0.0 Standard Class B network mask
255.255.128.0 Class B network, 2 subnetworks
255.255.192.0 Class B network, 4 subnetworks
255.255.224.0 Class B network, 8 subnetworks

255.255.255.0 Standard Class C network mask
255.255.255.128 Class C network, 2 subnetworks
255.255.255.192 Class C network, 4 subnetworks
255.255.255.224 Class C network, 8 subnetworks

Subnet mask IP AddressNetworkIdent Host Ident
255.255.255.0 192.9.200.100 192.9.200.0100

192.9.200.200 192.9.200.0200
255.255.255.128 192.9.200.200 192.9.200.0200
255.255.255.128 192.9.200.100 192.9.200.0100

192.9.200.200 192.9.200.12872
255.255.255.192 192.9.200.100 192.9.200.6436

192.9.200.200 192.9.200.1928
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3. Click on the Interface  field and select the interface type.

4. Click in the Next Hop  field and enter the address of the next hop.

5. Select the appropriate route type from the Route Type  field.

6. Click on the Add button.

Editing an IP Route

To edit an IP Route:

1. In the IP Destination Table  select the item that you want to edit.

The IP Routing information of the selected item appears in the Selected Entry Cri-
teria  fields.

2. Perform the desired changes.

3. Click on the Replace  button.

Deleting an IP Route

To delete an IP Route:

1. In the IP Destination Table  select the item that you want to delete.

2. Click on the Delete  button.

Metroplex 6000 Community Name Options

See Figure 5-28. The Metroplex 6000 Community Name Options  window enables you to 
define the SNMP Community Names that access the Metroplex 6000 and, through it, to the u
the Metroplex 6000 shelf.

Each Community Name, which is really a password, has an access level associated with it, o
you assign. If another user supplies the proper Community Name to the Metroplex 6000, tha
is granted access associated with the name. For example, if a Community Name of Public  has an 
access level of Read Only , then a user supplying this name can only read the MIBs.

The window is divided into three areas:

Community Option Description

Community Name Access Criteria Contains the Secret Community Name  input field and the Read Table  
button; this is a security feature and its use is described below.

Community Name Table Displays Community Names and access levels.

Selected Entry Criteria This is a workspace where you create, edit, or delete Community Names
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Figure 5-28 Community Names Options Configuration Window or Screen (6001)

SNMP uses Community Names to restrict access to an agent. There are three access levels
variables:

Read/Write

Read

No Access

Through its MIB, the Metroplex 6000 lets you add, delete, and view Community Names in a 
The Metroplex 6000 can store up to five Community Names, each with its associated acces
current status. Access for the Metroplex 6000 can be defined as read-only, read-write, or no-
A SuperUser Community Name is required to add and delete entries in the table. It acts as a
user Community Name and can be used to read or write any MIB Object. Factory default fo
SuperUser Community Name is SYSTEM. When the Metroplex 6000 is initially installed and 
powered up, it has one default Community Name, public , with read-only access. You can chang
both default Community Names.

The SuperUser Community Name can be changed only through the local management term
interface, using the TERM, DIAL , or SNMP port. If you choose the SNMP port, you can use Teln
By entering the System Utilities->Password  screen and thus changing Monitor , 
Diagnose , and Configure  selection, you can save a new SuperUser Community name.

At least one Community Name with read-write access must be set in the Community Name
before other MIB objects can be established using the Metroplex 6000. Use the SuperUser 
Community Name to set the first privileged Community Name, then employ that privileged 
Community Name to set all other MIB objects.

Metroplex 6001
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• Community Name MIB Description

In the GDCCMN-MIB there is a Community Name group. The maximum number of Commu
Names at any one time can be determined by reading the MIB variable cmnCommunityNumber . 
The Metroplex 6000 Community Name Table is in non-volatile RAM and need not be recrea
each time the Metroplex 6000 is powered up. When replacing an Metroplex 6000 you must 
manually delete unneeded entries.

The following information is defined in the Community Name Table:

• Configuration Procedures

Access Criteria

As a security measure access to the Metroplex 6000 Community Name Options configuratio
window requires a password procedure. When the window first appears, the Community Name 
Table  is blank, and both it and the Selected Entry Criteria  area are grayed out. 

To gain access to the window: 

1. Click in the Secret Community Name  entry field. 

2. Type in the super-user Community Name and press the Enter  key. 

3. Click on the Read Table  button. The application then displays the currently configure
Community Names in the Community Name Table and you can proceed.

 Adding a Community Name

To add a Community Name:

1. Click in the Community Name  field of the Selected Entry Criteria  area. 

2. Type in the new Community Name.

3. Click on the Access  field and select the type of access permitted.

4. Click on the Add button.

Editing a Community Name

To edit a Community Name in the display:

1. Click on the Community Name  that you want to edit in the Community Name Table.

Community Term Definition

Community Name String of up to 31 characters holds the Community Name; if you enter more than 31 ch
ters, the Metroplex 6000 ignores those in excess of 31

Access Access associated with the Community Name (read-write, read-only, no-access)

Note Super-user Community Name is set via the term port on the front panel of the platform card. Refer to
Local Management Manual (086R605-001).
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2. The name and access permission of the selected Community Name appear in the app
Selected Entry Criteria  fields.

3. Perform the desired changes.

4. Click on the Replace  button.

Deleting a Community Name

To delete a Community Name from the display:

1. Click on the Community Name that you want to delete in the Community Name Table.

2. Click on the Delete  button.

Reset/Restore

See Figure 5-29. The Metroplex 6001 Reset menu has two options: Reset to Factory 
Defaults , which lets you restore the user configuration to the original set-up configured by
manufacturer (factory defaults), and Perform Software Reset , which is the power-up 
sequence. 

Figure 5-29 Reset/Restore Screen (6001)

Messages

Do You Want to Continue? (OK/Cancel) Displayed if you selected Default Configuration. If you press Y the 
card is removed or set to default. If you press N you return to the 
screen.
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Platform Card Diagnostics Menu

See Figure 5-30 and refer to Table 5-16. The Platform Diagnostic menu is used to access the 
diagnostics for the LIU A and LIU B, and the card self-test for the card. Below figure illustrat
typical screen.

Figure 5-30 Platform Diagnostics Menu Screen (6001)
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File->Exit

Exits the application. See Figure 5-31.

Table 5-16 Platform LIU Diagnostic Selections and Messages (6001) 

Field Selection Description

LIU A  with Interface Type: CSU  and LIU B  with Interface Type: HDSL E1

Loopback None, To Channel,
Payload, Line

Specifies the possible loopbacks available. This selection is also
status field if the current active diagnostics is not a user selectab
option.

To Channel - this loopbacks all data to the channels and sends a
AIS to the network.

Payload - this loopback can be either a manager-initiated loopba
or can be started through the FDL. When started through the FD
it cannot be changed.

Line - this is a read-only network-initiated loopback.

Loopback Timeout 
(in minutes) 
(See Figure 5-33 and 
Table 5-18.)

1-255 Timeout used on manager-initiated tests. Default is 10 minutes.

Stop Loopback Performs the selected test on the card. This selection disrupts d

Start Loopback Stops the test that is in progress.

Time Remaining Time that is left to complete the current test.

Loopback Status The pass or fail results of the Loop Status , identified on the di-
agnostics platform card, are displayed on the screen.

Notes:

1. Dashes indicate the channel is not present. An option card may be missing.
2. A Network-initiated test overrides a manager-initiated test.
3. A Network-initiated T1 test overrides all Network-initiated channel tests.
4. See Figure 5-33 and Table 5-18 for active fields during HDSL interfacing.
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Figure 5-31 Exits the Application Screen (6001)

Navigate->History

Displays the history window. See Figure 5-32 and refer to Table 5-17.

Figure 5-32 Navigate->History Screen (6001)
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Loopback Timeout

Specifies the duration of the selected loop. See Figure 5-33 and refer to Table 5-18.

Figure 5-33 Loopback Times-Out Screen (6001)

Table 5-17 History (6001)

Field Description

Name Identifies the 6001 application that is currently connected to by displaying the user-configure
shelf name, followed by the CSU or DSX1 slot number, and the user-configured device name

Interface Type
(read-only)

Displayed are either CSU, DSX1, E1, HDSL E1, or HDSL T1.

Loopback Specifies the possible loopbacks available.

Table 5-18 Loopback Timeout 

Field Description

Start Loopback Starts the selected loopback test.

Stop Loopback Displayed are either CSU, DSX1, E1, HDSL E1, or HDSL T1.

Time Remaining Time that is left to complete the current test

Loopback Status The current loopback condition.
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History Window

This window gives you the diagnostics history for the card. See Figure 5-34.

Figure 5-34 Diagnostic History Window (6001)

The following fields are continuously updated only if an HDSL interface exists:

HDSL Loop Exchange No Exchange or Loops Exchanged.

Noise Margin This is the noise margin for an HDSL loop (in db).

Pulse Atten This is the pulse attenuation for an HDSL loop (in db).

Table 5-18 Loopback Timeout  (Continued)

Field Description
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Chapter 6: Flexi-Voice Card

Introduction
The Flexi-Voice Plus basecard, MP6360, provides various voice and four-wire data channe
accepts one, two or three dual-channel option cards, providing up to six channels. Option car
are Originate Battery (OB), configurable for FXS or DPO; Terminate Battery (TB), configura
for FXO or DPT; 4-wire E&M, 4-wire Transport Only (4W TO), OCU-DP, and G. 703.
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Flexi-Voice Card (6360)

Performance

You can choose from the main menu bar or the front panel select button.

Flexi-Voice Alarm Details Menu

Alarm detail selection brings you the following screen. The alarm detail screen is going to va
according to the option cards installed on the base card. See Figure 6-1 and refer to Table 6-1.

Figure 6-1 Alarm Detail Screen for Six Channels on Flexi-Voice Plus Screen
(6360--G.703 and OCU-DP only)

There are two alarms for the six channels, given in Table 6-1. Figure 6-1 shows you this screen.

LIU Alarm States (6360)
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Configuration

This Configuration Application gives you access to unit level parameters by SNMP queries 
windows are displayed or refreshed. You use the SNMP set commands to make changes to t
This application lets you copy configurations to other units. Configuration data is stored 
permanently and you can get at the stored data easily.

An expanded Configuration Library lets you store device configurations such that they are sa
flat file formats as templates. Thus, with template support, you use action buttons Save , Load , and 
Compare  which are accessed through the File  menu, and you specify the file name of the 
template by way of a dialog window.

Configuration

You can choose from the main menu bar or the front panel select button. Main Configuratio
Window is Read-Only Display.

From the 6360 Flexi-Voice Card Configuration Menu screen, you can select Channel 
Configurations for any of the following channel cards, providing the correct option card is in p
OCU, G.  703 , 4WE&M, FXS/LS , FXS/GS, DPO, 4WTO, FXO/LS, FXO/GS, and DPT. Figure 6-2 
illustrates a typical screen.

Figure 6-2 Typical Flexi-Voice Configuration Menu Screen (6360)

Table 6-1 LIU Alarm States (6360)

Alarm Fields LED Indications

Loss of Frame
Loss of Signal

Specifies the current alarm states of Channels 1 through 6.

Loss of Signal – occurs when the LIU detects an absence of network signal. Absence of s
for a time equivalent to 175 bits (± 75) is considered no signal. 

Loss of Frame – occurs when the LIU misses two out of four framing bits in the signal com
from the network. The count for this alarm increments by one each time framing is lost, reg
less of the number of frames affected. 
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The Main Configuration window displays the following read-only items:

Name: Symbol label corresponding to chosen slot symbol from shelf ma

Status: Unit status: Okay, Fail , Test , Standby , Diverse , Alarm

Firmware Revision: Revision code of unit firmware: -- , A- ,... AA,... ZZ

Hardware Revision: Revision code of unit hardware: -- , A- ,... AA,... ZZ

6000 Mib Version: 6000 mib version of unit: 1.00 ... 

6360 Mib Version: 6360 mib version of unit: 1.00 ... 

Channels 1-6: Displays either Not  Installed , Unknown, Originate  
Battery , Terminate  Battery , 4 Wire  E & M, 
Transmission  Only , OCU -  Data  Port , or G.703 . Indicates 
the type of channel card installed.

On the title bar is the application name, Metroplex  6360  Configuration . The menu bar has
File  for file operations, Navigation  for navigating through subordinate screens, and your ba
Help  info. In the lower right of the screen appear status messages giving you updates on th
performance of the application, that is, feedback on reading, writing, saving to template, and
forth.

Mandatory for all systems, the information in this group is read by the management station to
where elements exists in a shelf.

The following steps describe how to use the configuration application, and illustrate the func
of the 6360 Configuration window menus. 

1. Access the 6360 Configuration window, either from the submap menu bar or from the 
Front Panel display. The application reads the current 6360 configuration from the plat
card when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the channel continues to operate using it
changed current configuration. 

The Refresh  selection on the Main window File  menu causes the application to read th
current configuration from the channel. All changes to all configuration windows that h
not previously been saved to the channel or a template are lost when you select Refresh . 

2. To edit the current configuration of the channel, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 

Click on the Navigate  button to display a menu of the 6360 configuration windows, and sel
the one in which you intend to make changes. 

Make changes as needed in the configuration window. When you click on the input field for 
option, a window opens to display all the values the field can be set to. Click the mouse on the
you select. When you change the value or setting of an option, the application displays the 
name and the new value in white, rather than black, type. They remain white until you eithe
the changes to the channel or a template by means of the Main window File  menu, or restore the 
option to its last stored value or setting. 

You can discard changes to a 6360 configuration window and return all its fields to the
stored values in two ways:
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Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a 6360 configuration window without losing changes by clicking on eithe
OK button or the pushpin  icon , which is located in the upper left corner of the window

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The 6360 Main Configur
window remains on-screen throughout the configuration process. 

When you have accessed all the configuration windows that you need to and made all of yo
changes, click on the File  menu button of the 6360 Main Configuration window. From that me
you can select Save  to  Unit  to save the new configuration in the channel, or select Save  to  
Template  to save it as a template in the workstation. 

When you select Save  to  Unit , the changed configuration becomes the current configu
tion for the channel. 

When you select Save  to  Template , a window appears containing a list of existing template
and a field for entering a new template name. You can select an existing template to be over
with the new configuration, or enter a name to create a new template. A stored template is av
to be loaded by the application and then saved, with or without further modification, to any T
6000 channel.

 

Menu Buttons Menu Selections Results in: Further
Selections

File

Refresh Reading all options from 
unit and losing any out-
standing edits.

Save to Unit Sending all outstanding 
edits to unit.

Load Template... Letting you apply the ed-
its of an existing 
Metroplex MP6360 tem-
plate to the current appli-
cation. These template 
changes are done when 
you use the File-
>Save  to  Unit  com-
mand.

dialog window

Save to Template... Saving configuration data 
as a particular template.

dialog window

Compare to
Template..

Comparing configuration 
data with a particular tem-
plate.

dialog window

Exit First discarding outstand-
ing edits, then terminating 
application.
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• Flexi-Voice Channel Configurations

There are two types of screens: 4-wire data, which are digital type channel cards, and FXS/
which is a VF type channel card.

This screen changes depending on the option card installed. Figure 6-3 illustrates a typical digital 
type Channel Configuration screen and Table 6-2 explains each digital type option, where as
Figure 6-4 illustrates a typical VF FXS/LS Channel Configuration screen and Table 6-3 explains 
each VF type option.

Navigate

Channels, 1 -- 6 Op-
tions... 

Displaying the 
Metroplex  MP6360 
Channel  Options 
window.

options for 
each

All Screens... Displaying all subordi-
nate application win-
dows.

Help

Displaying help information.

Menu Buttons Menu Selections Results in: Further
Selections
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Figure 6-3 Channel 1 Digital Type, Data Port Interface Screen (6360)
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Table 6-2 Flexi-Voice Channel OCU and G. 703 Configuration Selections and Messages 

Field Selection Description

Option Type: (Read Only)

OCU-Data Port 
G.703

Specifies option type read from card. 
• When the Option Type field is designated as OCU - Data Port, the 

Interface Type field is inactive (grayed-out) and must select OCU - Da
Port.

• When the Option Type field designates G.703, Interface Type field is 
inactive (grayed-out) and must select G.703 with Data Rate being gray
out.

Interface Type: OCU-Data Port 
G.703

The interface type (how the channel is operating) is associated with this fi
• When the Option Type field is designated as OCU - Data Port, Interfac

Type field is inactive (grayed-out) and must select OCU - Data Port.

• When the Option Type field is designated as G.703, Interface Type field
inactive (grayed-out) and must select G.703.

LIU: A,B Allows you to select the LIU where a channel is assigned. The timeslots 
skipped if used somewhere else. 

When the LIU interface is set to Diverse Link, the LIU interface is grayed
out, forcing the interface to Selection A. Both A and B cause the Timeslot
be either grayed or un-grayed, depending on the available time slots spec
in the SNMP object mp6000LIUMap. When modified and thus its typed 
characters whitened, the Timeslot, by necessity, shows a change and is
cluded in the SNMP set-request.

Timeslot: Off , 1, 2,...., 31 Depending on the allocation for the time slot when you choose an LIU, th
field is grayed or is un-grayed. Timeslot shows a change (shown in white
LIU is modified.

If CAS is on and Digital Service is Switched, Timeslot is disabled and is 
the Off  mode.

If CAS is on, Selection 16 is grayed-out.

Digital
Service:

DDS,
DDS-SC, Switched 
56Kbps, and N/A

This is the service supported on the channel. N/A is always grayed-out.
• When the Digital Service field is designated as DDS - SC, the 64K bps

Data Rate field is grayed-out.

• When the Digital Service field is designated as Switched 56K, the Dat
Rate field is disabled (grayed-out) and must show 56K bps.

• When you choose Switched 56Kbps, Data Rate field is disabled (graye
out) and forced to 56Kbps.

• Digital Service field is inactive (grayed-out) and must become N/A whe
Option Type field is G.703.

Data Rate: 2.4 Kbps
4.8 Kbps
9.6 Kbps
19.2 Kbps
56 Kbps
64 Kbps

Data rates are supported at the channel interface.
• If the Option Type field is designated as G.703, the Data Rate field is 

grayed-out.

• If the Digital Service field is designated as Switched 56K, the Data Ra
field is grayed-out and has to be 56K bps.

• If the Digital Service field is designated as DDS-SC, 64K bps is grayed
out.

Zero Code
Suppression:

Enable, Disable, N/
A.

This specifies whether or not zero code suppression is used on the chan

The Zero Code Suppression field is inactive (grayed-out) and is set to N
if Option Type field is designated as G.703. N/A is always grayed-out.
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Latching
Loopback:

Enable, Disable, N/
A.

Support Latching DDS loopbacks. This can be enabled at all data rates.

Latching Loopback field is inactive (grayed-out) when Option Type field i
G.703. N/A is always grayed-out.

Hardware
Revision:

(Read-0nly)

-- , A- ,... AA,... ZZ

Gives you the hardware revision of the channel card.

Loss Of Frame This field allows you to configure the OCU Data Port and G.703 alarm 
porting.

Loss Of Signal This field allows you to configure the OCU Data Port and G.703 alarm r
porting.

When Option Type is G.703, this field is disabled (grayed-out).

Action Buttons

Ok Dismisses the window with current edits intact, which is the same as pin-pull (clicking on the 
located at the upper left-hand corner of the screen).

Reset Undoes pending or tentative edits since the last File->Save to Unit  command.

Cancel Same as Reset, it dismisses the screen.

Note: Defaults in bold.

Table 6-2 Flexi-Voice Channel OCU and G. 703 Configuration Selections and Messages  
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Figure 6-4 Channel 1 VF Type, FXS/LS Interface Screen (6360)

FXS/L Interface VF type channel options are presented below in Table 6-3.
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Table 6-3 Flexi-Voice Channel FXS/LS Configuration Selections and Messages (6360)

Field Selection Description

Option Type (Read-Only)

Originate  Battery , 
Terminate  Battery ,
4-Wire  E & M,
Transmission  Only
OCU-DP, and G.703

Indicates type of channel card installed.
• If the Option Type field is Originate Battery, the Interface Type

field shows these selections grayed-out: FXO-Loop Start, FXO
Ground Start, DPT, E and M, 4 Wire TO, OCU-Data Port, and
G.703.

• If the Option Type field is Terminate Battery, the Interface Type
field has these selections grayed-out: FXS-Loop Start, FXS-
Ground Start, DPO, E and M, 4 Wire TO, OCU-Data Port, and
G.703.

• If the Option Type field is 4 Wire E & M, the Interface Type field 
is inactive (grayed-out) and must select E and M.

• If the Option Type field is Transmission Only, Interface Type 
field is inactive (grayed-out) and must select 4 Wire TO.

Interface Type: FXS-Loop  Start , 
FXS-Ground Start , 
DPO, FXO-Loop  
Start , FXO-Ground  
Start , DPT, E and  M, 4 
Wire  TO, OCU-Data  
Port , and  G.703

The interface type (how the channel is operating) is associated w
the option type. Selections OCU - Data Port and G.703 are alwa
seen as grayed-out on the screen.
• If the Option Type field is Originate Battery, FXO-Loop Start, 

FXO-Ground Start, DPT, E and M, and 4 Wire TO are grayed-
out.

• If the Option Type field is Terminate Battery, FXS-Loop Start, 
FXS-Ground Start, DPO, E and M, and 4 Wire TO are grayed-
out.

• If the Option Type field is Transmission Only, the Interface Type
field is grayed-out and must select E and M.

• If the Option Type field is 4 Wire E and M, Interface Type field 
is grayed-out and must select 4 Wire TO.

• If you set the Interface Type field to FXS-Ground Start, you 
gray-out PLAR in the Signalling Mode field.

• If you set the Interface Type field to DPO, you gray-out 
Signalling Mode field and make it select Standard .

LIU: A, B This allows you to select LIU where a channel is assigned. The tim
slots are skipped if used somewhere else.

When the LIU interface is set to Diverse Link, the LIU interface is
grayed out, forcing the interface to Selection A. Both A and B caus
the Timeslot to be either grayed or un-grayed, depending on the
available time slots specified in the SNMP object mp6000LIUMap
When modified and thus its typed characters whitened, the 
Timeslot, by necessity, shows a change and is included in the 
SNMP set-request.

Timeslot: Off , 1, 2,...., 31 Depending on the allocation for the time slot when you choose a
LIU, this option is grayed or is un-grayed. Timeslot shows a chang
(shown in white) if LIU is modified.

This field is disabled and forced to off if CAS is off and interface is
not Type 4 Wire TO.

If CAS is on, Selection 16 is grayed-out.
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For each channel, there is an option type defined (Table 6-4). Refer to Hardware Manual
(086R603-001) for other option types, configuration, and definitions.

TLP Default: Default  1, Default  
2, Default  3

When set, the data displayed in Total Tx TLP and in Total Rx TLP
is recalculated. When modified, this option is shown in white and
Adjust Tx TLP and Adjust Rx TLP indicate that they have been 
changed.

Adjust Tx TLP: In dBs: -6.0 , -5.9 ,
-5.8 ..., 5.9 , and 6.0
(intervals of +/-0.1) 

Choose any dB and the data then displayed in Total Tx TLP is re
calculated. If modified, the TLP Default indicates that it has been
changed. As a result, this mib object is included in an SNMP set
request when the TLP Default is sent. 

Total Tx TLP: (Read-Only) Data is calculated when the values of Adjust Tx TLP and TLP D
fault are added together.

Adjust Rx TLP: In dBs: -6.0 , -5.9 ,
-5.8 ..., 5.9 , and 6.0
(intervals of +/-0.1) 

Choose any dB and the data then displayed in Total Rx TLP is r
calculated. If modified, TLP Default indicates that it has been 
changed. As a result, the mib object is included in an SNMP set-r
quest when the TLP Default is sent.

Total Rx TLP: (Read-Only) Data is calculated when the values of Adjust Rx TLP and TLP D
fault are added together.

Signalling Mode: No Signalling
Standard ,
Conversion ,
and PLAR

• If the Interface Type field is FXS-Loop Start, the No Signalling
field is disabled.

• If the Interface Type field is FXS-Ground Start, both the No 
Signalling field and PLAR are disabled.

• If the Interface Type field is DPO, or if the Option Type field is 
either Terminate Battery or 4 Wire E & M, the Signalling Mode
field is grayed-out and must select Standard.

• If the Option Type field is Transmission Only, the Signalling 
Mode field is grayed-out and must select No Signalling.

Hardware
Revision:

(Read-0nly)

-- , A- ,... AA,... ZZ

Gives you the hardware revision of the channel card.

Action Buttons

Ok Dismisses the window with current edits intact, which is the same as pin-pull (clicking on th
pin located at the upper left-hand corner of the screen).

Reset Undoes pending or tentative edits since the last File->Save to Unit  command.

Cancel Same as Reset, it dismisses the screen.

Note: Defaults in bold.

Table 6-3 Flexi-Voice Channel FXS/LS Configuration Selections and Messages (6360)
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The Total Receive TLP (Transmission Level Point) specifies the value for the voice channels
interface types depend on the option types (Table 6-5):

Reset

Figure 6-5 Reset/Restore Screen (6360)

The Metroplex 6360 Reset menu has two options: Reset to Factor Defaults , which lets 
you restore the user configuration to the original set-up configured by the manufacturer (fac
defaults), and Perform Software Reset , which is the power-up sequence. See Figure 6-5 
and refer to Table 6-6.

Table 6-4 Option Type (6360)

Option Type Card Identification

UNKNOWN
0B
TB
4WE&M
TO
OCU-Data Port
G. 703

Unknown 
Originate Battery
Terminate Battery
4-Wire E & M
Transmission Only
OCU - Data Port
G. 703

Table 6-5 Interface Type (6360)

Option Type Interface Type

Unknown
0B
TB
4WE&M
TO
OCU-Data Port
G. 703

FXS-Loop Start, FXS-Ground Start, DPO
FXO-Loop Start, FXO-Ground Start, DPT
EANDM
TO
OCU-Data Port
G. 703
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Flexi-voice Card Diagnostics Menu

The Flexi-Voice Diagnostic menu is used to access the diagnostics for the channels. Figure 6-6 
illustrates a typical screen. Table 6-7 presents selections and messages for these channels (Se
screens for diagnostic tests in hardware manuals).

Figure 6-6 Flexi-Voice Plus Diagnostics Menu Screen (6360)

Table 6-6 Flexi-Voice Card Configuration Messages (6360)

Messages

Do You Want to Continue? (OK/Cancel) Displayed if you selected Default Configuration. If you presY 
the card is removed or set to default. If you press N you return to 
the screen.

Table 6-7 Flexi-Voice Channel Diagnostic Selections and Messages (6360) 

Field Selection Description

Loopback Status Read-Only Shows any currently active loops on the channel.
No TimeSlot indicates timeslot is not assigned to channel and therefore the l
back cannot be started.

[Comm Error], [Comm Timeout] indicates communications problems with th
platform card.

Digital mWatt Sta-
tus

Read-Only  Shows the current digital milli-watt status for the channel.

Conditioning

Status

Read-Only  Shows the current conditioning status for the channel.
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Misc

Flexi-Voice Voice/Four-Wire Data Monitor Menus

The Flexi-Voice and Voice/Four-Wire menu are used to access the monitor screen for the F
Voice and Voice/Four-Wire channels. Figure 6-7 illustrates a typical screen.

Local Loopback To Network, 
None, Network

Specifies the available loopbacks. The VF path is looped, but not the signal
This selection is also a status field if the current active diagnostic is not a u
selectable option.

ToNet loops the received signal back towards the network. 

Network - this is a read-only network-initiated loopback for the 4WTO interfac
type.

Dig. mWatt 

(Digital Millwatt)

OFF, ON Allows you to inject a 1000 Hz test tone at a 0 dBm level into the receive ti
slot towards the channel card interface. It appears on the channel interface
1000 Hz receive signal at a level equal to the assigned TLP level. If the chan
interface is also put into loopback, this signal is looped back into the transm
timeslot. Disabled for E1 LIU.

Conditioning FBNI, FIdle, 
FBusy, None

Conditions the channel and network interface to a known state. 

FBNI - Force Busy Next Idle, forces the channel busy after it goes to an idle
state.

FIdle - Force Idle, immediately conditions the channel to idle.

FBusy - Force Busy, immediately conditions the channel to busy.

None - performs no conditioning

Notes: 

1. Dashes in the interface type indicate the channel is not present. An option card may be missing. When the int
type is displayed, but the selections contain dashes, the option type cannot be tested through the current screen

2. Digital Milli-watt can only be performed on a voice channel over T1 service. This test terminates after a 10-min
timeout.

3. Local Loopback, Dig. mWatt and Conditioning are not available on unconfigured channels.

Table 6-7 Flexi-Voice Channel Diagnostic Selections and Messages (6360)  (Continued)
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Figure 6-7 Flexi-Voice and Voice/Four-Wire Channel Monitor Screen (6360)

• OCU-DP Channel Monitor

The OCU-DP Channel monitor screen shows configuration, diagnostics, and alarm informati
the OCU-DP channels on the Flexi-Voice card. Refer to Table 6-8 for the monitored selections.

Table 6-8 OCU-DP Channel (6360)

Field Values Description

Impedance 600, 900, N/A Indicates the value read from the option card. 600 or 900 Ohms is
from the jumper set on the TB option card. All other option card typ
read N/A.

Signaling Type I, II, III, V, N/A Indicates the value read from the option card.

I, II, III, V signaling type is read from the jumper set on the E&M op
tion card. All other option card types read N/A.

Channel Status Idle, Busy Indicates the current status of the channel. 

Busy means the channel is currently being used.

Idle indicate the channel is available for use.

Out of Service Off, On, N/A, - Network Out Of Service code received from the network.
N/A is displayed when the channel is not configured or is running a
64kbps.

Tx Mode Control, Data, N/A, - Indicates whether the channel is transmitting data or control infor
tion from the DSU.
N/A is displayed when the channel is not configured, when an alarm
active or when a ToNet or OCU loopback is active.

Alarms None, LOS, LOF, N/A, - Specifies the current alarm state of the channel.

LOS - Loss of signal detected.

LOF - Loss of Frame detected.

N/A is displayed when the channel is not configured.
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Chapter 7: Flexi-Data Card

Introduction
The Flexi-Data basecard, MP6441, provides up to four single-channel data interfaces. Each c
supports rates of 9.6, 56 and 64K b/s, and is fully DDS-compatible. Option card types availab
EIA-232AS, EIA232, V.35, and 422/V.11. (For descriptions of the front panel LEDS, refer to th
hardware manual. Note also that flashing LEDs are not supported.)
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Flexi-Data Card (6441)

Performance

The Flexi-Data (6441) card does not have a performance selection from the front panel sele
button.

Configuration

Configuration

You can choose from the main menu bar or the front panel select button (Figure 7-1).

Figure 7-1 Configuration - Flexi-Data (Main) Screen (6441)

The Main Configuration window displays the following read-only items:

Name: user-configured name for the LIU 

Status: Okay or Fail

Firmware Revision: revision level of the LIU operating code

Hardware Revision: revision level of the LIU hardware

6000 MIB Version: revision level of the MIB files that enable Team 6000 control 

6441 MIB Version: revision level of the MIB files that enable 6441 card control

Channel 1-4: Display either Not  Installed  or option type for the channel plug
in. card.

The following steps describe how to use the configuration application, and illustrate the func
of the 6441 Configuration window menus (See Figure 7-1). 
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1. Access the 6441 Configuration window, either from the submap by clicking on 
Configuration---->Configuration  or from the 6441 Front Panel display by 
clicking on the select button on the front panel Configuration----
>Configuration . The application reads the current 6441 configuration from the LIU
when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the LIU continues to operate using its un
changed current configuration. 

The Refresh  selection on the Main window File  menu causes the application to read th
current configuration from the LIU. All changes to all configuration windows that have 
previously been saved to the LIU or a template are lost when you select Refresh . 

2. To edit the current configuration of the LIU, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 

3. Click on the Navigate  button to display a menu of the 6441 configuration windows, an
select the channel to be modified. 

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. Click the mo
on the value you select. When you change the value or setting of an option, the applic
displays the option name and the new value in white, rather than black, type. They rem
white until you either save the changes to the LIU or a template by means of the Main
window File  menu, or restore the option to its last stored value or setting. 

You can discard changes to a 6441 configuration window and return all its fields to the
stored values in two ways:

Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a 6441 configuration window without losing changes by clicking on eithe
OK button or the pushpin  icon , which is located in the upper left corner of the window

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The 6441 Main Configur
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made al
your changes, click on the File  menu button of the 6441 Main Configuration window. 
From that menu you can select Save  to  Unit  to save the new configuration in the LIU, o
select Save  to  Template  to save it as a template in the workstation. 

When you select Save  to  Unit , the changed configuration becomes the current configu
tion for the LIU. 

6. When you select Save  to  Template , a window appears containing a list of existing 
templates and a field for entering a new template name. You can select an existing tem
to be overwritten with the new configuration, or enter a name to create a new template
stored template is available to be loaded by the application and then saved, with or wit
further modification, to any Team 6000 LIU.
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• Flexi-Data Channel Configurations

When you click the mouse on the entry field for a configuration item, a window opens conta
all the values that are permitted for that configuration item. Hold down the mouse button un
highlight is on the value you intend to configure, then release the button. The newly selected
appears in the entry field for the configuration item. There are four types of channel cards ava
EIA-232AS, EIA232, V.35, and 422/V.11. Refer to Table 7-1 and Figure 7-2.

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template... dialog window

Save to Template... dialog window

Compare to Template... dialog window

Exit

Navigate

Channel 1 Options

Channel 2 Options

Channel 3 Options

Channel 4 Options

All Screens... 
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Figure 7-2 Flexi-Data Channel Configuration Screen (6441)
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Table 7-1 Flexi-Data Configuration Selections and Messages (6441) 

Field Selection Description

Option Type
(read only)

422/V.11, V.35, 
EIA530A, Unknown

Specifies Option Type read from card. Unknown indicates Platform card does 
recognize Option Type. Check revision compatibility.

Interface 
Type

X.21, EIA530A, 
V.36

The interface type (how the channel is operating) is associated with the option 

X.21, EIA530A, V.36 are available with the 422/V.11 option card.

V.35 V.35 is available with the V.35 card.

EIA232 EIA232 is available with the EIA232 card.

EIA232AS EIA232AS is available with the EIA232AS card.

LIU A,B Displays the LIU used and allows you to select the LIU to which a channel is a
signed. If LIU B is not present only A is available.

Timeslot 1-24 and Off Displays the plug-in cards by timeslot and allows you to select the timeslot to wh
a channel is assigned. The timeslots are skipped if used somewhere else.

’0’ (zero) can be used to specify Off.

This field is disabled (grayed-out) and forced to off if CAS is off and Digital Servic
is Switched 56Kbps.

Selection 16 is grayed-out if CAS is on.

Digital
Service DDS, 

Switched 56K

The service supported on the channel.
DDS - compatible with DDS service.
Sw56 - Switched 56Kbps data service.

When you choose Switched 56Kbps, Data Rate is disabled (grayed-out) and fo
to 56Kbps.

Selection Switched 56Kbps is grayed-out when CAS is off.

Data Mode Sync, Async Sync: disables the data rate selections, 1.2Kbps and 1.8Kbps.
Async: disables the data rate selections, 5.6Kbps and 6.4Kbps.

Data Rate 1.2Kbps, 1.8Kbps, 
2.4Kbps, 9.6Kbps, 
19.2Kbps, 56Kbps, 
and 64Kbps

The data rate supported at the channel interface.

Default data rate for EIA232 and EIA 232 ASYNC is 9.6Kbps, all other option typ
default is 56Kbps.

When Digital Service is Switched 56k, data rate is disabled (grayed-out) and for
to 56Kbps.

Selections 64Kbps and 56Kbps are disabled (grayed-out) when Data Mode is 
Async. Selections 1.8Kbps and 1.2Kbps are disabled (grayed-out) when data m
is Sync.

Ext.
Transmit 
Timing

Off , On Off - Data channel uses internal timing to clock in transmit data from the DTE.

On - Timing provided by the DTE on the External Timing lead used to clock in 
transmit data. External Timing must be synchronous to the Metroplex 6000 inte
timing.

This field is disabled (grayed-out) when data mode is Async.

DCD
Control

Force-on,
Controlled

This controls the DCD control lead to the local DTE interface.   The setting depe
on the equipment connected to the interface. At 64Kbps, the interface is forced

CTS Control Force-on, Switched,
N/A

This controls the CTS control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64Kbps, the interface is forced
Displays N/A for Interface Type of X.21.

DSR Control Force-on,
Controlled, N/A

This controls the DSR control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64Kbps, the interface is forced
Displays N/A for Interface Type of X.21.
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Reset

Figure 7-3 Reset/Restore Screen (6441)

The Metroplex 6441 Reset menu has two options: Reset to Factor Defaults , which lets 
you restore the user configuration to the original set-up configured by the manufacturer (fac
defaults), and Perform Software Reset , which is the power-up sequence. See Figure 7-3.

Fault

Flexi-Data Card Diagnostics Menu

For the TEAM 6000, the 6441 Flexi-Data Card initiates a loopback towards any of the four cha
by way of test equipment. The loopback test verifies the intergroup of the option card and the
DCD, CTS, and DSR on the channel interface are all set to Off during this loopback when th
channel is configured for DCD: Normal, CTS: Switched, and DSR: Normal. The timing option
this card, which is called the External  Transmit  Timing  Off  or On, is clocked into the 
Flexi-Data card and is responsible for system and loop timing. The screen in Figure 7-4 shows the 
options for Channel 1 for a particular interface. Refer to Table 7-2.

Latching 
Loopback

Enable, Disable Support Latching DDS loopbacks. This can only be enabled at 64Kbps data ra

Character 
Size

Bits: 8, 9, 10, and 11 This feature is disabled when Data Mode is Sync.

Hardware
Revision

(Read-0nly)

-- , A- ,... AA,... ZZ

Gives you the hardware revision of the option card.

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select save first. If y
select Cancel , the screen becomes active and you can then select the save op
If you select OK, the screen is exited and the configuration changes are lost.

Notes:

1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays on the
an SNMP general error.

2. Defaults in bold.

Table 7-1 Flexi-Data Configuration Selections and Messages (6441)  (Continued)

Metroplex 6441 Reset

Flexi-Data Card
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Figure 7-4 Channel 1 EIA-530A Diagnostics Screen (6441)

 

Misc

Flexi-Data Card Monitor Menu

The Flexi-Data Monitor menu is used to access the monitor screen for selected channels.
Figure 7-5 illustrates this screen.

Table 7-2 Flexi-Data Channel Diagnostic Selections and Messages (6441)

Field Selection Description

Loopback 
Status

Read-Only Shows any currently active loops on the channel.
No TimeSlot indicates timeslot is not assigned to channel and therefore the loopback
cannot be started.

[Comm Error], [Comm Timeout] indicates communications problems with the plat-
form card.

Local 
Loopback

ToDTE, To 
Network, OCU, 
CSU, DSU, 
None.

Specifies the available loopbacks.

ToDTE loops data towards the channel and can be used on an unconfigured channe

ToNet loops received data from the network towards the network.

OCU, CSU, DSU are read-only and indicate the presence of a network-initiated loop-
back. If any of these are in effect, you cannot perform a manager-initiated loopback
on that channel. (See screens for diagnostic tests in hardware manuals)

Notes: 

1. Dashes indicate the channel is not present. An option card may be missing.

2. All Local Loopback selections, except ToDTE, are not available on unconfigured channels.

3. DDS network-initiated loopbacks are stopped if a T1 network loopback is initiated.
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Figure 7-5 Flexi-Data Monitor Menu Card Screen (6441)

• Channel Monitor

The channel monitor screen shows configuration and diagnostics information for the channe
the Flexi-Data card. Refer to Table 7-3.

Table 7-3 Channel Status Values (6441 Card)

Field Description

Option Type Option cards for Channels 1, 2, 3, and 4. Channels are supported in a single timeslot at 56k or 64k
format.

Interface Type Interfaces are EIA-232AS, EIA232, V.35, X.21 (byte timing is not supported), EIA-530-A, and V.36

RTS Received-to-Send - On = local DTE in Data Mode, Off = local DTE in Control Mode                                       

DCD Data Carrier Detect - On = remote DTE in Data Mode, Off = remote DTE in Control Mode, can be fo
On

DTR Data Terminal Ready - displays the current status of local DTE interface.

Out of Service Network Out Of Service code received from the network.

N/A is displayed when the channel is not configured or is running at 64Kbps.
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Chapter 8: Frac-Data Card

Introduction
The Frac-Data basecard, MP6520, provides one or two high-speed data channels, at rates 
N x 56kb/s or N x 64 kb/s.   Option card types available are V.35, 422/V.11 and DSX-1. (For 
descriptions of the front panel LEDS, refer to the hardware manual. Note also that flashing L
are not supported.)
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Frac-Data Card (6520)

Performance

You can choose from the main menu bar or the front panel select button.

Frac-Data Alarm Details Menu

Alarm detail selection brings you the following screen. The alarm detail screen is going to va
according to the option cards installed on the base card. See Figure 8-1 and refer to Table 8-1.

Figure 8-1 Frac-Data Card Alarm Detail Screen (6520 Card)

Configuration 6520

Configuration

Selection from the main menu bar or the front panel select switch. Main Configuration Windo
Read-Only Display.

From the 6520 Frac-Data Card Configuration Menu screen, you can select N x 56/64k Chan
Configuration for V.35, EIA-530A, etc. channels, and DSX-1 Channel Configuration for DSX
channels. Figure 8-2 illustrates a typical screen. 

Table 8-1 Alarm Detail States (6520 Card)

Alarm Fields LED Indications

Channel 1 and Channel 2
Out Of Frame and Loss of Signal

Remote Alarm Indication

Specifies the current alarm states of Channel 1 and Channel 2.
LOS (Loss of Signal) or OOF (Out of Frame) is detected as defined in TR
62411.

RAI (Remote Alarm Indication) is being received from the network.
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Figure 8-2 Frac-Data Configuration Menu Screen (6520 Card)

The Main Configuration window displays the following read-only items:

Name: user-configured name for the LIU 

Status: On Line or Off Line

Firmware Revision: revision level of the LIU operating code

Hardware Revision: revision level of the LIU hardware

6000 MIB Version: revision level of the MIB files that enable Team 6000 control 

6520 MIB Version: revision level of the MIB files that enable 6520 card control

Channels 1 and 2: Display either Not  Installed  or option type for the channel plug
in card.

Mandatory for all systems, the information in this group is read by the management station to
where elements exists in a shelf.

The following steps describe how to use the configuration application, and illustrate the func
of the 6520 Configuration window menus (See Figure 8-2). 

1. Access the 6520 Configuration window, either from the submap menu bar or from the 
Front Panel display. The application reads the current 6520 configuration from the LIU
when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the LIU continues to operate using its un
changed current configuration. 

The Refresh  selection on the Main window File  menu causes the application to read th
current configuration from the LIU. All changes to all configuration windows that have 
previously been saved to the LIU or a template are lost when you select Refresh . 

2. To edit the current configuration of the LIU, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 
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3. Click on the Navigate  button to display a menu of the 6520 configuration windows, an
select the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. Click the mo
on the value you select. When you change the value or setting of an option, the applic
displays the option name and the new value in white, rather than black, type. They rem
white until you either save the changes or a template by means of the Main window File  
menu, or restore the option to its last stored value or setting. 

You can discard changes to a 6520 configuration window and return all its fields to the
stored values in two ways:

Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a 6520 configuration window without losing changes by clicking on eithe
OK button or the pushpin  icon , which is located in the upper left corner of the window

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The 6520 Main Configur
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made al
your changes, click on the File  menu button of the 6520 Main Configuration window. 
From that menu you can select Save  to  Unit  to save the new configuration in the LIU, o
select Save  to  Template  to save it as a template in the workstation. 

When you select Save  to  Unit , the changed configuration becomes the current configu
tion for the LIU. 

6. When you select Save  to  Template , a window appears containing a list of existing 
templates and a field for entering a new template name. You can select an existing tem
to be overwritten with the new configuration, or enter a name to create a new template
stored template is available to be loaded by the application and then saved, with or wit
further modification, to any Team 6000 LIU. 

Menu Buttons Menu Selections Further Selections

File

Refresh

Save to Unit

Load Template... dialog window

Save to Template... dialog window

Compare to Template... dialog window

Exit

Navigate

Channels, 1 and 2 
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n. 
• Frac-Data Channel Configurations

There are two types of screens: DSX-1 and Nx56/64k.

This screen changes depending on the option card installed. Figure 8-3 illustrates a typical DSX-1 
Channel 1 Configuration screen. Figure 8-4 illustrates a typical V.35 Channel Configuration scree
Refer to  and Table 8-3, which follow the screen figures below. 

Figure 8-3 Frac-Data DSX-1 Channel 1 Configuration Screen (6520 Card)

All Screens... 

Menu Buttons Menu Selections Further Selections
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Figure 8-4 Frac-Data V.35 Channel Configuration Screen (6520 Card)

Table 8-2 Frac-Data DSX-1 Channel Configuration Selections and Messages (6520 Card)

Field Selection Description

Option Type

(read only)

DSX-1, Unknown Specifies Option Type read from card. Unknown indicates Platform card doe
recognize Option Type. Check revision compatibility.

Data Rate N x 64k This specifies the channel rate. N = number of timeslots dedicated to the ch

Interface Type DSX-1 The interface type is DSX-1.

LIU A,B Allows you to select the LIU to which a channel is assigned. If LIU B is not pres
only A is available.

Start Timeslot 1-24 and Off Allows you to select the start timeslot to which a channel is assigned. The times
are skipped if used somewhere else.

0 (zero) can be used to specify Off.

Number of 
Timeslots

0 and 1-24 Allows you to select the number of timeslots for the channel. Maximum numbe
timeslots may be less than 24 if timeslots are used somewhere else.

Line Code B8ZS, AMI Allows you to select either B8ZS or AMI as the line code for the channel.

Frame Type ESF, D4 Allows you to select either ESF or D4 as the framing format for the channel.
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Pre-Equaliza-
tion

0 - 133 ft

133 - 266 ft

266 - 399 ft

399 - 533 ft

533 - 655 ft

Allows you to select the pre-equalization which corresponds to the line  length
used.

Channel Type Clear, Signaling Select Signaling for voice channels or  Switched 56 data channels which req
robbed-bit signaling. Otherwise select Clear which passes all eight bits of the 
timeslot.

Messages

Application Has Pending Edits (OK/
Cancel)

Displayed if you made a change on the screen, but did not select save first. If
select OK the screen becomes active again and you can then select the save o
If you select Cancel , the screen is exited and the configuration changes are lo

Notes: 

1. Dashes in the option type indicate the channel is not present. An option card may be missing. When the option
displayed, but the selections contain dashes, the option type cannot be configured through the current screen.

2. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays on the s
SNMP general error 

3. When Communication Error, Channel Card Not Changed appears on the screen, the Platform card had proble
municating to the specified channel card. This could be due to a missing channel card. If the channel card is not 
from the shelf, check the firmware revisions. 

4. Defaults in bold.

Table 8-3 Frac-Data N x 56/64k Channel Configuration Selections and Messages (6520 Card) 

Field Selection Description

Option Type
(read only)

422/V.11, V.35, 
EIA232, Un-
known

Specifies Option Type read from card. Unknown indicates Platform card does 
recognize Option Type. Check revision compatibility.

N x 56k /64k 56k, 64k This specifies a single timeslot rate.

Interface Type X.21, EIA530A, 
V.36

The interface type (how the channel is operating) is associated with the option t

X.21, EIA530A, V.36 are available with the 422/V.11 option card.

V.35 V.35 is available with the V.35 card.

LIU A,B Allows you to select the LIU to which a channel is assigned. If LIU B is not prese
only A is available.

Start Timeslot 1-24 and Off Allows you to select the start timeslot to which a channel is assigned. The times
are skipped if used somewhere else.

’0’ (zero) can be used to specify Off.

Number of 
Timeslots

0 and 1-24 Allows you to select the number of timeslots for the channel. Maximum numbe
timeslots may be less than 24 if timeslots are used somewhere else.

Alternate 
Timeslots

Off , On Allows you to select the use of alternate timeslots. This may be required to sa
One’s Density requirement (Density requirement of Numeric 1). 

Off - Only the Number of Timeslots is used.

On - Two times the Number of Timeslots specified are used. The alternate 
timeslots are filled with the idle code to the network and do not carry customer
ta. If not enough timeslots are available, this option is not be available.

Table 8-2 Frac-Data DSX-1 Channel Configuration Selections and Messages (6520 Card) 
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PN127 (RmtLp-
bk) Response

Enable, Disable Enable - Allows the channel to detect PN127 loop up codes (ANSI T1.403-19

Disable - Data channel does not go into network loopback if the PN127 loop u
code is received.

Ext. Transmit 
Timing

Off , On Off - Data channel uses internal timing to clock in transmit data from the DTE

On - Timing provided by the DTE on the External Timing lead used to clock in
transmit data. External Timing must be synchronous to the Metroplex 6000 in
nal timing.

Invert Transmit 
Timing

Normal, On Normal - Leaves the transmit timing in its normal state.

On - Used to invert the transmit timing from the DTE.   This may be beneficial
when using high data rates and long cables.

Ext. Loopback 
Control

Enable, Disable, 
N/A

Enable - allows the channel to use the V.54 control leads to cause a local loop
(LL) or a remote loopback (RL)

Disable - Data channel does not go into a loopback with the request from the V
control leads. Displays N/A for Interface Type of X.21. 

DCD Control Forced-on, Con-
trolled

This controls the DCD control lead to the local DTE interface.   The setting de
pends on the equipment connected to the interface. At 64kbps, the interface i
forced-on.

 CTS Control Forced-on, 
Switched,

N/A

This controls the CTS control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64kbps, the interface is forced
Displays N/A for Interface Type of X.21.

DSR Control Forced-on, Con-
trolled,

N/A

This controls the DSR control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64kbps, the interface is forced
Displays N/A for Interface Type of X.21.

Messages

Application Has Pending Edits (OK/
Cancel)

Displayed if you made a change on the screen, but did not select save first. If 
select OK the screen becomes active again and you can then select the save op
If you select Cancel , the screen is exited and the configuration changes are lo

Notes: 

1. Dashes in the option type indicate the channel is not present. An option card may be missing. When the option
displayed, but the selections contain dashes, the option type cannot be configured through the current screen.

2. Some configuration parameters are not changeable when a channel is in a diagnostic test.

3. When Communication Error, Channel Card Not Changed appears on the screen, the Platform card had proble
municating to the specified channel card. This could be due to a missing channel card. If the channel card is not 
from the shelf, check the firmware revisions.

4. Defaults in bold.

Table 8-3 Frac-Data N x 56/64k Channel Configuration Selections and Messages (6520 Card)  
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Reset/Restore

Figure 8-5 Reset/Restore Screen (6520 Card)

The Metroplex 6520 Reset menu has two options: Reset to Factor Defaults , which lets 
you restore the user configuration to the original set-up configured by the manufacturer (fac
defaults), and Perform Software Reset , which is the power-up sequence. See Figure 8-5.

Messages are listed in Table 8-4.

Fault

Frac-Data Card Diagnostics Menu

The Frac-Data Diagnostic menu is used to access the diagnostics for the N x 56/64k channel
1 channels and the card selftest for the card. Figure 8-6 illustrates a typical screen. Table 8-5 and  
present selections and messages for N x 56/64k channels.

Table 8-4 Frac-Data Card Configuration Messages (6520 Card)

Messages

Do You Want to Continue? (OK/Cancel) Displayed if you selected Default Configuration. If you press Y the 
card is removed or set to default. If you press N you return to the 
screen.

Frac-Data Card

Metroplex 6520 Reset
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 8-9
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Figure 8-6 Frac-Data Diagnostics Menu Screen (6520 Card)

N x 56/64K Channel diagnostics (6520 Frac-Data Card)

 

Table 8-5 Frac-Data N x 56/64k Channel Diagnostic Selections and Messages (6520 Card) 

Field Selection Description

Bit Error Rate These values are 
not selectable by 
the user. 

This read-only field is used to indicate the bit error rate when Pattern Genera
is started.

Total Bit Errors These values are 
not selectable by 
the user. 

This read-only field is used to indicate the total number of errors for the elap
time.

Elapsed Time These values are 
not selectable by 
the user. 

This read-only field specifies the elapsed time since the Pattern Generation
started and the pattern has been synchronized.

Off - when Pattern Generation is set to None.

NoSync - when Pattern Generation is set to 511 or 2047, but the pattern is 
currently being detected.

Elapsed Time - is displayed in italics since the actual value indicates days, ho
minutes and seconds.

Loopback Status Read-Only Shows any currently active loops on the channel.
No TimeSlot indicates timeslot is not assigned to channel and therefore the l
back cannot be started.

[Comm Error], [Comm Timeout] indicates communications problems with th
platform card.
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Remote Loop-
back Status

Read-Only Shows current remote loopback status for the channel.

Current Pattern Read-Only Shows current remote loopback status for the channel.

Local Loopback ToChan, ToNet, 
None, DTE-LL, 
DTE-RL, 
PN127Loop

Specifies the available local loopbacks. 

ToChan loops the data back to the channel interface.

ToNet loops the data back towards the network. 

DTE-LL, DTE-RL and PN127Loop are read-only and indicate the presence o
network-initiated or DTE-initiated loopback. If any of these are in effect, a ma
ager-initiated loopback cannot be started on that channel.

Remote Loop-
back

Off, On Allows you to send a PN127 Loop-up pattern into the network.

If a Local Loopback is active, a Remote Loopback cannot be performed

Pattern Genera-
tion

None, 511, 2047 Allows a test pattern to be sent to the network. If both the Remote Loopbac
Pattern Generation are started at the same time. the Remote Loopback is s
first and then the Pattern is sent.

If a Local Loopback is active, Pattern Generation cannot be started.

Notes: 

1. Dashes in the interface type indicate the channel is not present. An option card may be missing. When the int
type is displayed, but the selections contain dashes, the option type cannot be tested through the current screen

2. Local Loopback, Remote Loopback and Pattern Generation are not available on unconfigured channels.
3. If a network loopback is started on a channel while in the diagnostics screen, the user must try to select a Loc
back to see the loopback. Remote Loopback and Pattern Generation indicates that the network loopback is activ
does not update the Local Loopback selection. (See screens for diagnostic tests in hardware manuals)

Table 8-5 Frac-Data N x 56/64k Channel Diagnostic Selections and Messages (6520 Card)  
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DSX-1 Channel Diagnostics (6520 Frac-Data Card)

The DSX-1 Channel Diagnostic selections are shown in , which presents diagnostic selectio

Misc

Frac-Data Card Monitor Menu

The Frac-Data Monitor menu is used to access the monitor screen for the DSX-1 and Nx56
channels. Figure 8-7 illustrates a typical screen.

Figure 8-7 Frac-Data Card Monitor Menu Screen (6520 Card)

• DSX-1 Channel Monitor

DSX-1 Channel monitor screen shows configuration, diagnostics, and alarm information for
DSX-1 channels on the Frac-Data card. Refer to  for the monitored selections.

Table 8-6 Frac-Data DSX-1 Channel Diagnostic Selections and Messages (6520 Card)

Field Selection Description

Local Loopback ToChan, ToNet, None Specifies the available loopbacks.
ToChan loops the data back to the channel interface.
ToNet loops the data back towards the network.

Table 8-7 DSX-1 Channel Alarm Values (6520 Card)

Field Values Description

Alarms Channel 1 and Channel 2
Out Of Frame and Loss of 

Signal

Remote Alarm Indication

Specifies the current alarm states of Channel 1 and Channel 2.
LOS (Loss of Signal) or OOF (Out of Frame) is detected as defined in T
62411.

RAI (Remote Alarm Indication) is being received from the network.

None No alarms
8-12 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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• N x 56/64k Channel Monitor

N x 56/64k Channel monitor screen shows the configuration, diagnostics, alarm and status 
information for the N x 56/64k channels on the Frac-Data card. Table 8-8 describes additional status
values.

Table 8-8 N x 56/64k Channel Status Values (6520 Card)

Field Values Description

TX(RTS) Off, On Displays the current status of the local DTE interface RTS lead.

RX(DCD) Off, On Displays the current status of the local DCD lead.

DTR Off, On Displays the current status of the local DTE interface DTR lead.

RL/LL Off, RL, LL Displays the current status of the local RL and LL leads.

TM Off, TM Displays the current status of the TM lead.
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 8-13
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Chapter 9: FXS Octet Card

Introduction
The FXS Octet card, MP6380, provides eight channels of FXS-type voice, similar to the Dua
Option card on the Flexi-Voice Plus card. The FXS Octet does not accept any option card n
provide any other, except FXS Loop Start, FXS Ground Start, or DPO. (For descriptions of the
panel LEDS, refer to the hardware manual. Note also that flashing LEDs are not supported.
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FXS Octet Card (MP6380)

Configuration MP6380

Configuration

You can access the Metroplex 6380 Configuration window from the HPOV Map Configuratio
Menu, that is, select from the main menu bar or the front panel select switch. Main Configur
Window, which is read-only, is made up of pop-up menus and eight channel windows or scr
for working with your unit. Figure 9-1 shows the Metroplex 6380 Configuration screen (FXS 
Octet  Card ).

 

Figure 9-1 FXS Octet Configuration Menu Screen (MP6380)
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The Main Configuration window displays the following read-only items:

Name: Symbol label corresponding to chosen slot symbol from shelf ma

Status: Unit status: Okay, Fail , Test

Firmware Revision: Revision code of unit firmware: -- , A- ,... AA,... ZZ 

Hardware Revision: Revision code of unit hardware: -- , A- ,... AA,... ZZ

6000 Mib Version: 6000 mib version of unit: 1.00 ... 

6380 Mib Version: 6380 mib version of unit: 1.00 ... 

On the title bar is the application name, Metroplex  6380  Configuration . The menu bar has
File  for file operations, Navigation  for navigating through subordinate screens, and your ba
Help  info. In the lower right of the screen appear status messages giving you updates on th
performance of the application, that is, feedback on reading, writing, saving to template, and
forth.

How to Use the MP6380 Configuration

The following steps describe how to use the configuration application and illustrate the func
of the MP6380 Configuration window menus. 

1. Access the MP6380 Configuration window, either from the submap menu bar or from 
MP6380 Front Panel display. The application reads the current MP6380 configuration 
the platform card when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the channel continues to operate using it
changed current configuration. 

The Refresh  selection on the Main window File  menu (Figure 9-2) causes the application
to read the current configuration from the platform card. All changes to all configuration
dows that have not previously been saved to the channel or a template are lost when yo
Refresh .

Figure 9-2 FXS Octet Configuration, Main File Screen (MP6380)

2. To edit the current channel configuration, go directly to the Navigate  menu described 
below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 
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3. Click on the Navigate  button to display a list of eight MP6380 option windows and an
option window for All  Screens... . Then, choose an option window for making chang
to a specific channel by clicking it with the mouse (Figure 9-3).

Figure 9-3 FXS Octet Configuration, Main Navigation Screen (MP6380)

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. (Refer to FXS/LS 
Octet Channel Configuration Options for the MP6380 following this section). Click the 
mouse on the value you select. When you change the value or setting of an option, the
application displays the option name and the new value in white, rather than in black, 
New values remain in white type until you either save the changes to a template by me
the Main window File  menu, or you restore the option to its last stored value or setting

You can discard changes to a MP6380 configuration window and return all its fields to
stored values in two ways:

Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a MP6380 configuration window without losing any changes by clicking
either the OK button or the pushpin  icon , which is located in the upper left corner of th
window.

You can keep multiple configuration windows open on the screen and be able to move a
them so that you can choose a window to work with by clicking the mouse on it. The MP
Main Configuration window remains on-screen throughout the configuration process. 

5. When you have finally accessed all the configuration windows that you wanted and ma
of your changes, click on the File  menu button of the MP6380 Main Configuration 
window. From that menu you can select Save  to  Unit  to retain the new configuration in 
the channel, or else select Save  to  Template  to save it as a template in the workstation

When you select Save  to  Unit , the changed configuration is now the new or latest con
uration for the channel. 

6. When you select Save  to  Template , a window appears having a list of existing templat
and a field for entering a new template name. You can select an existing template to b
overwritten with the new configuration, or enter a name to create a new template. A st
template is available to be loaded by the application and then saved, with or without fu
modification.
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Below is a summary of the menu buttons for doing any configuring.

 

• FXS Octet Card Channel Options

You access this screen when you click on Navigate->Channel  1, 2,...,8 Options .
Figure 9-4, showing you a channel FXS/LS interface, uses the Channel 1 Options screen as
example. For definitions or functions for the fields on the screen, refer to Table 9-1 following 
Figure 9-4.

Menu 
Buttons

Menu Selections Results in: Further S
lections

File

Refresh Reading all options from unit and losing any outstanding edits.

Save to Unit Sending all outstanding edits to unit.

Load Template... Letting you apply the edits of an existing Metroplex MP6380 
template to the current application. These template changes are 
done when you use the File->Save to Unit  command.

dialog wind

Save to Template... Saving configuration data as a particular template. dialo

Compare to
Template...

Comparing configuration data with a particular template. dialog 

Exit First discarding outstanding edits, then terminating application.

Navigate

Channels, 1 -- 8 Op-
tions... 

Displaying the Metroplex  MP6380 Channel  Options 
window.

options for 
each

All Screens... Displaying all subordinate application windows.

Help

Displaying help information.
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Figure 9-4 FXS/LS Octet Channel 1 Options Screen (MP6380)

Table 9-1 FXS/LS Octet Channel Configuration (MP6380) 

Field Selection Description

Interface Type: FXS-Loop  Start , 
FXS-Ground Start , 
DPO

Set to FXS-Ground Start grays the selection PLAR in Signalling 
Mode.

Set to DPO grays Signalling Mode, forcing Signalling Mode to Sta
dard.

LIU: A, B When the LIU interface is set to Diverse Link, the LIU interface is
grayed out, forcing the interface to Selection A. Both A and B cau
the Timeslot to be either grayed or un-grayed, depending on the 
available time slots specified in the SNMP object mp6000LIUMap
When modified and thus its typed characters whitened, the Times
by necessity, shows a change and is included in the SNMP set-re
quest.
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Reset/Restore

Figure 9-5 Reset/Restore Screen (FSX Octet Card)

The Metroplex 6380 Reset menu has two options: Reset to Factor Defaults , which lets 
you restore the user configuration to the original set-up configured by the manufacturer (fac
defaults), and Perform Software Reset , which is the power-up sequence. See Figure 9-5.

Timeslot: Off , 1, 2,...., 31                                       Depending on the allocation for the time slot when you choose an
LIU, this option is grayed or is un-grayed. Timeslot shows a chan
(shown in white) if LIU is modified.

This field is disabled and forced to off if CAS is off.

Selection 16 is grayed-out if CAS is on.

TLP Default: Default  1, Default  2, 
Default  3

When set, the data displayed in Total Tx TLP and in Total Rx TLP
is recalculated. When modified, this option is shown in white and
Adjust Tx TLP and Adjust Rx TLP indicate that they have been 
changed.

Adjust Tx TLP: In dBs: -6.0 , -5.9 ,
-5.8, 0.0 , ..., 5.9 , and 
6.0
(intervals of +/-0.1) 

Choose any dB and the data then displayed in Total Tx TLP is rec
culated. If modified, the TLP Default indicates that it has been 
changed. As a result, this mib object is included in an SNMP set-
quest when the TLP Default is sent. 

Total Tx TLP: Read-only Data is calculated when the values of Adjust Tx TLP and TLP D
fault are added together.

Adjust Rx TLP: In dBs: -6.0 , -5.9 ,
-5.8, 0.0 , ..., 5.9 , and 
6.0
(intervals of +/-0.1) 

Choose any dB and the data then displayed in Total Rx TLP is rec
culated. If modified, TLP Default indicates that it has been change
As a result, the mib object is included in an SNMP set-request wh
the TLP Default is sent.

Total Rx TLP: Read-only Data is calculated when the values of Adjust Rx TLP and TLP D
fault are added together.

Signalling Mode: Standard ,
Conversion , and PLAR

• If the Interface Type is FXS-Ground Start, PLAR is disabled.

• If the Interface Type is DPO, Signalling Mode is grayed and 
becomes Standard.

Action Buttons

Ok Dismisses the window with current edits intact, which is the same as pin-pull (clicking on the
located at the upper left-hand corner of the screen).

Reset Undoes pending or tentative edits since the last File->Save to Unit  command.

Cancel Same as Reset, it dismisses the screen.

Note: Defaults in bold.

Table 9-1 FXS/LS Octet Channel Configuration (MP6380)  (Continued)
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Messages are listed in Table 9-2.

Fault

FXS Octet Card Diagnostics Menu

You can access the Metroplex 6380 Diagnostics window from the HPOV Map Fault Menu, th
select from the main menu bar or the front panel select switch. The application, made up of
one main window and one transient window that gives you a diagnostic history of each chan
Figure 9-6 shows the Metroplex 6380 Diagnostics screen (FXS Octet  Card ) and Figure 9-7 
typifies the diagnostic history screen for the eight channels. Regarding the diagnostics histo
screen, note that the displayed data is not retained in memory and becomes lost as soon as
the diagnostic application. The application name is on the title bar, and on the menu bar, yo
basic help, file access, and navigation through subordinate screens. Each of the eight chann
its own diagnostics test information. Refer to Table 9-3 for functions of the eight-channel 
diagnostics tests and to Table 9-4 for history data on channel diagnostic tests. 

Figure 9-6 FXS Octet Diagnostics Menu Screen (MP6380)

Below is a summary of the menu button functions for diagnostic tests.

Table 9-2 FSX Octet Configuration Messages (FSX Octet Card)

Messages

Do You Want to Continue? (OK/Cancel) Displayed if you selected Default Configuration. If you press Y the 
card is removed or set to default. If you press N you return to the 
screen.
9-8 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01
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Menu Buttons Menu Selections Results in:

File->

Exit Terminating the application.

Navigate

History Displaying the MP6380 Diagnostics history window.

Help

Displaying help information.

Table 9-3 FXS Octet Channel Diagnostic Selections and Messages (MP6380) 

Field Selection Description

Loopback
Status

Read-Only Shows any currently active loops on the channel.
No TimeSlot indicates timeslot is not assigned to channel and therefore 
loopback cannot be started.

[Comm Error], [Comm Timeout] indicates communications problems with
the platform card.

Digital mWatt Status Read-Only  Shows the current digital milliwatt status for the channel.

Conditioning

Status

Read-Only  Shows the current conditioning status for the channel.

Local Loopback To Network, None, 
Network

Specifies the available loopbacks. The VF path is looped, but not the sig
ing. This selection is also a status field if the current active diagnostic is 
a user selectable option.

ToNet loops the received signal back towards the network. 

Network - this is a read-only network-initiated loopback for the 4WTO inte
face type.

Dig. mWatt 

(Digital Millwatt)

OFF, ON Allows you to inject a 1000 Hz test tone at a 0 dBm level into the receive t
slot towards the channel card interface. It appears on the channel interfac
a 1000 Hz receive signal at a level equal to the assigned TLP level. If th
channel interface is also put into loopback, this signal is looped back into
transmit timeslot. Disabled for E1 LIU
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Figure 9-7 FXS Octet Diagnostics History Screen for the Channels (MP6380)

 

Conditioning FBNI, FIdle, 
FBusy, None

Conditions the channel and network interface to a known state. 

FBNI - Force Busy Next Idle, forces the channel busy after it goes to an i
state.

FIdle - Force Idle, immediately conditions the channel to idle.

FBusy - Force Busy, immediately conditions the channel to busy.

None - performs no conditioning

Notes: 

1. Dashes in the interface type indicate the channel is not present. An option card may be missing. When the interf
is displayed, but the selections contain dashes, the option type cannot be tested through the current screen.

2. Digital Milli-watt can only be performed on a voice channel over T1 service. This test terminates after a 10-min
timeout.

3. Local Loopback, Dig. mWatt and Conditioning are not available on unconfigured channels. (See screens for dia
tests in hardware manuals)

Table 9-4 FXS Octet Channel Diagnostic Selections and Messages (MP6380) 

Field Selection Description

Start Time: Read-only When the testing was done

Chan: Read-only Channel that was tested

Loop: Read-only Loopback that was used (if any)

DmWatt: Read-only Digital milliwatt setting that was used (if any)

Cond: Read-only Conditioning selected (if any)

Loop Results: Read-only First response returned after start of operation

Action Button

Ok Dismisses the window with current edits intact, which is the same as pin-pull (clicking on the
located at the upper left-hand corner of the screen).

Table 9-3 FXS Octet Channel Diagnostic Selections and Messages (MP6380)  (Continued)
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Misc

FXS Octet Card Monitor Menu

You can access the Metroplex 6380 Monitor window from the HPOV Map Misc Menu, that i
select from the main menu bar or the front panel select switch. The application, made up of
one screen, monitors eight channels. Figure 9-8 shows the Metroplex 6380 Monitor screen (FXS 
Octet  Card ). The application name is on the title bar, and on the menu bar, you find basic
and file access. Arrayed in eight columns are channel data, with each of the eight channels
displaying its own interface type and status.

Figure 9-8 FXS Octet Card Monitor Menu Screen (MP6380)

At the footer (bottom of the screen) is the status message area, where you can read the sta
current activity of the monitor application. Also, displayed there are messages describing un
interaction and giving you the time when the screen was last refreshed with data. Thus, bein
consistent with other TEAM applications, the format for this footer is constantly updated suc
Last  Update:  Tue June  25  09:59:53  1996 .

Below is a summary of the menu button functions for monitoring. Also, refer to Table 9-5.

Menu Buttons Menu Selections Results in:

File

Refresh Polling the unit for new data.

Exit Terminating the application.

Help

Displaying manual for the TEAM 6000 application.

Table 9-5 FXS Octet Channel Monitoring (MP6380) 

Field Selection Description

Channel Status: Idle  or Busy Busy means that the channel is now in use.

Idle means that the channel is now available.
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Chapter 10: Frac-Data Card

Introduction
The Frac-Data basecard, MP6521, provides one or two high-speed data channels, at rates 
N x 56kb/s or N x 64 kb/s.   Option card types available are V.35, 422/V.11, DSX-1, and Fra
(For descriptions of the front panel LEDS, refer to the hardware manual. Note also that flash
LEDs are not supported.)
086R608-V300-01 GDC TEAM 6000 for Unix ®  Metroplex - 6000 10-1



Frac-Data Card Frac-Data Card (6521)

ry 
moved 
Frac-Data Card (6521)

Performance

You can choose from the main menu bar or the front panel select button.

Frac-Data Alarm Details Menu

Alarm detail selection brings you the following screen. The alarm detail screen is going to va
according to the option cards installed on the base card. Alarms that are not applicable are re
from the screen and the screen is reduced in size vertically. See Figure 10-1 and refer to Table 10-1.
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Figure 10-1 Frac-Data Card Alarm Detail Screen (6521)
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Configuration 6521

Configuration

Selection from the main menu bar or the front panel select switch. Main Configuration Windo
Read-Only Display.

From the 6521 Frac-Data Card Configuration Menu screen, you can select N x 56/64k Chan
Configuration for V.35, EIA-530A, etc. channels, and DSX-1 Channel Configuration for DSX
channels. Figure 10-2 illustrates a typical screen. 

Figure 10-2 Frac-Data Configuration Menu Screen (6521)

The Main Configuration window displays the following read-only items:

Name: user-configured name for the LIU 

Status: On Line or Off Line

Firmware Revision: revision level of the LIU operating code

Hardware Revision: revision level of the LIU hardware

6000 MIB Version: revision level of the MIB files that enable Team 6000 control 

Table 10-1 Alarm Detail States (6521)

Alarm Fields LED Indications

Channel 1 and Channel 2
Out Of Frame
Loss of Signal

Remote Alarm Indication
All Ones Indication

Timeslot 16 Out Of Frame1 
Timeslot 16 Remote Alarm Indication1 
Timeslot 16 All Ones Signal1

Specifies the current alarm states of the Channel 1, the Channel 2.
LOS (Loss of Signal) or OOF (Out of Frame) is detected as defined in 
62411.

RAI (Remote Alarm Indication) is being received from the network.
AIS (Alarm Indication Signal) is being received from the network. 

Notes: 1Only applicable when mp6520OptionType  is E1.
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6521 MIB Version: revision level of the MIB files that enable 6521 card control

Channels 1 and 2: Display either Not  Installed  or option type for the channel plug
in card.

Mandatory for all systems, the information in this group is read by the management station to
where elements exists in a shelf.

The following steps describe how to use the configuration application, and illustrate the func
of the 6521 Configuration window menus (See Figure 10-2). 

1. Access the 6521 Configuration window, either from the submap menu bar or from the 
Front Panel display. The application reads the current 6521 configuration from the LIU
when you open the Main window. 

You can select to base your configuration changes on either the current configuration 
stored configuration template. In either case, the LIU continues to operate using its un
changed current configuration. 

The Refresh  selection on the Main window File  menu causes the application to read th
current configuration from the LIU. All changes to all configuration windows that have 
previously been saved to the LIU or a template are lost when you select Refresh . 

2. To edit the current configuration of the LIU, proceed directly to the Navigate  menu as 
described below. 

To edit a template, select Load  Template  from the File  menu and select a template from
the resulting list. 

3. Click on the Navigate  button to display a menu of the 6521 configuration windows, an
select the one in which you intend to make changes. 

4. Make changes as needed in the configuration window. When you click on the input fie
an option, a window opens to display all the values the field can be set to. Click the mo
on the value you select. When you change the value or setting of an option, the applic
displays the option name and the new value in white, rather than black, type. They rem
white until you either save the changes or a template by means of the Main window File  
menu, or restore the option to its last stored value or setting. 

You can discard changes to a 6521 configuration window and return all its fields to the
stored values in two ways:

Click on the Reset  button to discard changes while keeping the window open

Click on the Cancel  button to discard changes and close the window. 

You can close a 6521 configuration window without losing changes by clicking on eithe
OK button or the pushpin  icon , which is located in the upper left corner of the window

You can keep multiple configuration windows open on-screen and move between them
clicking the mouse on the one in which you intend to operate. The 6521 Main Configur
window remains on-screen throughout the configuration process. 

5. When you have accessed all the configuration windows that you need to and made al
your changes, click on the File  menu button of the 6521 Main Configuration window. 
From that menu you can select Save  to  Unit  to save the new configuration in the LIU, o
select Save  to  Template  to save it as a template in the workstation. 

When you select Save  to  Unit , the changed configuration becomes the current configu
tion for the LIU. 
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6. When you select Save  to  Template , a window appears containing a list of existing 
templates and a field for entering a new template name. You can select an existing tem
to be overwritten with the new configuration, or enter a name to create a new template
stored template is available to be loaded by the application and then saved, with or wit
further modification, to any Team 6000 LIU.

 

• Frac-Data Channel Configurations

There are two types of screens: DSX-1 and Nx56/64k.

This screen changes depending on the option card installed. Figure 10-3 illustrates a typical 
interface type DSX-1 configuration screen for Channel 1. Figure 10-4 illustrates another typical 
configuration screen for Channel 1, whose option is E1 and interface type is EIA-530A . Refer to 
Table 10-2 and Table 10-3, which follow the screen figures below. 

Menu Buttons Menu Selections Further Selec-
tions

File

Refresh

Save to Unit

Load Template... dialog window

Save to Template... dialog window

Compare to Template... dialog window

Exit

Navigate

Channels, 1 and 2 

All Screens... 
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Figure 10-3 Frac-Data Interface  Type  DSX-1 Configuration Screen (6521)
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Figure 10-4 Frac-Data T1 Interface  Type  EIA-530A  Configuration Screen (6521)
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Table 10-2 Frac-Data DSX-1 Channel Selections and Messages (6521 Card) 

Field Selection Description

Option Type
(read only)

DSX-1, Unknown Specifies Option Type read from card. Unknown indicates Platform card doe
recognize Option Type. Check revision compatibility.

Interface Type DSX-1 The interface type is DSX-1.

LIU A,B Allows you to select the LIU to which a channel is assigned. If LIU B is not pres
only A is available.

Start Timeslot 1-31 and Off Allows you to select the start timeslot to which a channel is assigned. The times
are skipped if used somewhere else.

0 (zero) can be used to specify Off.

The selections for this feature are grayed-out/not grayed-out based on the time
allocation for the selection for the LIU. This feature is forced to indicate a chan
(displayed in white) when an LIU is modified. When this selection is off, Numb
Of Timeslots is disabled (grayed-out) and forced to off.

Selection 16 is grayed-out if CAS is on.

Number of 
Timeslots

0 and 1-31 Allows you to select the number of timeslots for the channel. Maximum numbe
timeslots may be less than 31 if timeslots are used somewhere else.

This feature is disabled (grayed-out) when Start Timeslot is off.

This feature is forced to indicate a change (displayed in white) when the LIU i
modified.

Line Code B8ZS, AMI Allows you to select either B8ZS or AMI as the line code for the channel.

Frame Type ESF, D4 Allows you to select either ESF or D4 as the framing format for the channel.

Pre-Equaliza-
tion

0 - 133 ft

133 - 266 ft

266 - 399 ft

399 - 533 ft

533 - 655 ft

Allows you to select the pre-equalization which corresponds to the line  length
used.

Channel Type Clear, Signaling Select Signaling for voice channels or  Switched 56 data channels which req
robbed-bit signaling. Otherwise select Clear which passes all eight bits of the 
timeslot.

Alarms Reported

Out Of Frame
Loss Of Signal

None, OOF, LOS, 
N/A, - where the 
red LED lights up 
if there is an alarm 
condition.

OOF (Out of Frame) is detected as defined in TR 62411.
LOS (Loss of Signal) is detected as defined in TR 62411.

All Ones
Indication

An unframed, all 
ones signal Minor 
Alarm:
on=yellow, 
off=dark green.

AIS (Alarm Indication Signal) is being received from the network.

Remote alarm 
Indication

None, LOS, LOF, 
N/A, - where the 
red LED lights up 
if there is an alarm 
condition.

RAI (Remote Alarm Indication) is being received from the network.
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Messages

Application Has Pending Edits (OK/
Cancel)

Displayed if you made a change on the screen, but did not select save first. If
select OK the screen becomes active again and you can then select the save o
If you select Cancel , the screen is exited and the configuration changes are lo

Notes: 

1. Dashes in the option type indicate the channel is not present. An option card may be missing. When the option
displayed, but the selections contain dashes, the option type cannot be configured through the current screen.

2. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays on the s
SNMP general error 

3. When Communication Error, Channel Card Not Changed appears on the screen, the Platform card had proble
municating to the specified channel card. This could be due to a missing channel card. If the channel card is not 
from the shelf, check the firmware revisions. 

4. Defaults in bold.

Table 10-3 Frac-Data EIA-530A T1 Configuration Selections (6521 Card) 

Field Selection Description

Option Type
(read only)

422/V.11, V.35, 
EIA232,
Unknown

Specifies Option Type read from card. Unknown indicates Platform card does
recognize Option Type. Check revision compatibility.

Interface Type X.21, EIA530A, 
V.36

The interface type (how the channel is operating) is associated with the option 
X.21, EIA530A, and V.36 (available with the 422/V.11 option card).

V.35 V.35 is available with the V.35 card.

Data Rate N  x 56k/64k Kbps 
(Kilobytes
per second)

These are the terminal communications parameters:
data rate = 9600 bps 4character format = 1 start bit
8 data bits
no parity
1 stop bit

LIU A,B Allows you to select the LIU to which a channel is assigned. If LIU B is not prese
only LIU A is available.

Start Timeslot 1-31 and Off Allows you to select the start timeslot to which a channel is assigned. The times
are skipped if used somewhere else.

0 (zero) can be used to specify Off .

The selections for this feature are grayed-out/not grayed-out based on the time
allocation for the selection for the LIU. This feature is forced to indicate a chan
(displayed in white) when an LIU is modified. When this selection is off, Numb
Of Timeslots is disabled (grayed-out) and forced to off.

Selection 16 is grayed-out if CAS is on.

Number of 
Timeslots

Off and 1-31 Allows you to select the number of timeslots for the channel. Maximum numbe
timeslots may be less than 31 if timeslots are used somewhere else.

This feature is disabled (grayed-out) when Start Timeslot is off. All selections t
cannot provide contiguous timeslots, based on the setting of Start Timeslot, are
abled (grayed-out). However, when Timeslot 16 is used for timing (CAS is on), and 
therefore not available, straddling of this timeslot is permitted.

This feature is forced to indicate a change (displayed in white) when the LIU i
modified.

Table 10-2 Frac-Data DSX-1 Channel Selections and Messages (6521 Card)  (Continued)
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Figure 10-5 and Table 10-4 cover the attributes of the fractional E1 channel options screen be
This screen is shown when Navigate->Channel n Options  is selected and the mp6520 
OptionType  is E1. This screen allows configuration of the channel options applicable to this 
of channel.

Alternate 
Timeslots

Off , On Allows you to select the use of alternate timeslots. This may be required to sa
One’s Density requirement (Density requirement of Numeric 1). 

Off - Only the Number of Timeslots is used.

On - Two times the Number of Timeslots specified are used. The alternate times
are filled with the idle code to the network and do not carry customer data. If n
enough timeslots are available, this option is not be available.

This feature is disabled (grayed-out) when mp6001InterfaceType  is E1.

PN127 RDL
Response

Enable, Disable Enable - Allows the channel to detect PN127 loop up codes (ANSI T1.403-19

Disable - Data channel does not go into network loopback if the PN127 loop u
code is received.

Ext. Transmit 
Timing

Off , On Off - Data channel uses internal timing to clock in transmit data from the DTE

On - Timing provided by the DTE on the External Timing lead used to clock in
transmit data. External Timing must be synchronous to the Metroplex 6000 inte
timing.

Invert Transmit 
Timing

Normal, On Normal - Leaves the transmit timing in its normal state.

On - Used to invert the transmit timing from the DTE.   This may be beneficial
when using high data rates and long cables.

Ext. Loopback 
Control

Enable, Disable, 
N/A

Enable - allows the channel to use the V.54 control leads to cause a local loop
(LL) or a remote loopback (RL)

Disable - Data channel does not go into a loopback with the request from the V
control leads. Displays N/A for Interface Type of X.21. 

DCD Control Forced-on,
Controlled

This controls the DCD control lead to the local DTE interface.   The setting depe
on the equipment connected to the interface. At 64kbps, the interface is forced

CTS Control Forced-on, 
Switched, N/A

This controls the CTS control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64kbps, the interface is forced
Displays N/A for Interface Type of X.21.

DSR Control Forced-on,
Controlled, N/A

This controls the DSR control lead to the local DTE interface. The setting depe
on the equipment connected to the interface. At 64kbps, the interface is forced
Displays N/A for Interface Type of X.21.

Messages

Application Has Pending Edits
(OK/Cancel)

Displayed if you made a change on the screen, but did not select save first. If
select OK the screen becomes active again and you can then select the save op
If you select Cancel , the screen is exited and the configuration changes are lo

Notes: 

1. Dashes in the option type indicate the channel is not present. An option card may be missing. When the option
displayed, but the selections contain dashes, the option type cannot be configured through the current screen.

2. Some configuration parameters are not changeable when a channel is in a diagnostic test.

3. When Communication Error, Channel Card Not Changed appears on the screen, the Platform card had proble
municating to the specified channel card. This could be due to a missing channel card. If the channel card is not 
from the shelf, check the firmware revisions.

4. Defaults in bold.

Table 10-3 Frac-Data EIA-530A T1 Configuration Selections (6521 Card)  (Continued)
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Figure 10-5 Frac-Data E1 Interface  Type  Configuration Screen (6521)

Table 10-4 Frac-Data E1 Configuration Selections and Messages (6521) 

Field Selection Description

Name Read-Only This field is read-only and contains the ‘Symbol Label’ of the sele
ed slot symbol from the shelf map.

Option Type
(read-only)

E1 Card This field is read-only and specifies the particular 6000 option in-
stalled.

Interface Type
(read only)

E1 This feature is always disabled (grayed-out). 

LIU A,B Allows you to select the LIU to which a channel is assigned. If LIU
B is not present, only LIU A is available.

Start Timeslot 1-31 and Off Allows you to select the start timeslot to which a channel is assigne
The timeslots are skipped if used somewhere else.

0 (zero) can be used to specify Off .

The selections for this feature are grayed-out/not grayed-out base
on the time slot allocation for the selection for the LIU. This feature
is forced to indicate a change (displayed in white) when an LIU is
modified. When this selection is off, Number Of Timeslots is dis-
abled (grayed-out) and forced to off.

Selection 16 is grayed-out if CAS is on.
10-12 GDC TEAM 6000 for Unix ®  Metroplex - 6000 086R608-V300-01



Frac-Data Card Frac-Data Card (6521)

xi-
d 

l 
set-

n 

 

l.

on 
Number of 
Timeslots

Off and 1-31 Allows you to select the number of timeslots for the channel. Ma
mum number of timeslots may be less than 31 if timeslots are use
somewhere else.

This feature is disabled (grayed-out) when Start Timeslot is off. Al
selections that cannot provide contiguous timeslots, based on the 
ting of Start Timeslot, are disabled (grayed-out). However, when 
Timeslot 16 is used for timing (CAS is on), and therefore not avail-
able, straddling of this timeslot is permitted.

This feature is forced to indicate a change (displayed in white) whe
the LIU is modified.

CRC4 On or Off When Frame Type is D4, ESF Mode is disabled (grayed-out).

(CAS) Channel 
Associated
Signal

Read-only This turns Channel Associated Signaling on or off.

Impedance
(read-only)

75 Ohms,
120 Ohms, or Jumper Error

Specifies the Line Impedance.

Hardware Rev
(read-only)

--, A-,..., AA,... ZZ Current hardware version. 

Alarms Reported

Loss Of Frame 
and 
Loss Of Signal

None, LOS, LOF, N/A, - 
where the 
red LED lights up if there is 
an alarm condition.

Specifies the current alarm state of the channel.

LOS - Loss Of Signal detected.

LOF - Loss Of Frame detected. (OCU-DP only)

N/A is displayed when the channel is not configured or the following
diagnostics are active on an OCU-DP channel: ToNet, OCU-LL, 
OCU-NLL.

All Ones Signal An unframed, all ones sig-
nal Minor Alarm:
on=yellow, off=dark green.

AIS (Alarm Indication Signal) is being received from the channel.

Remote Alarm
Indication

Reception of remote alarm 
indication signal on the T1/
E1 interface
Minor Alarm:
on=yellow, off=dark green.

RAI (Remote Alarm Indication) is being received from the channe

Timeslot 16 Alarms Reported

Out Of Frame
All Ones Signal

Red LED lights up if there 
is an alarm condition.

Specifies the current alarm state of Timeslot 16 on the Frac E1 opti
type.

OOF (Out Of Frame) is detected.

AIS (Alarm Indication Signal) is being received from the channel.

The alarm condition results when there is no T1 signal.

Table 10-4 Frac-Data E1 Configuration Selections and Messages (6521)  (Continued)

Field Selection Description
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Figure 10-6 Reset/Restore Screen (6521 Card)

The Metroplex 6521 Reset menu has two options: Reset to Factor Defaults , which lets 
you restore the user configuration to the original set-up configured by the manufacturer (fac
defaults), and Perform Software Reset , which is the power-up sequence. See Figure 10-6.

Messages are listed in Table 10-5.

Fault

Frac-Data Card Diagnostics Menu

The Frac-Data Diagnostic menu is used to access the diagnostics for the N x 56/64k channel
1 channels and the card selftest for the card. Figure 10-7 illustrates a typical screen. Table 10-6 and  
present selections and messages for N x 56/64k channels.

Remote Alarm
Indication

Reception of remote alarm 
indication signal on the T1/
E1 interface
Minor Alarm: on=yellow, 
off=dark green.

RAI (Remote Alarm Indication) is being received from the channe

Messages

Application Has Pending

Edits (OK/Cancel)

Displayed if you made a change on the screen but did not select sa
first. If you select Cancel , the screen becomes active and you can
then select the save option. If you select OK, the screen is exited and 
the configuration changes are lost.

Notes: 1. Some configuration parameters are not changeable when an LIU is in a diagnostic test, which displays
screen an SNMP general error.             2. Defaults in bold.

Table 10-5 Frac-Data Card Configuration Messages (6521)

Messages

Do You Want to Continue? (OK/Cancel) Displayed if you selected Default Configuration. If you press Y the 
card is removed or set to default. If you press N you return to the 
screen.

Table 10-4 Frac-Data E1 Configuration Selections and Messages (6521)  (Continued)

Field Selection Description

Metroplex 6521 Reset

Flexi-Data Card
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Figure 10-7 Frac-Data Diagnostics Menu Screen (6521)

N x 56/64K Channel diagnostics (6521 Frac-Data Card)

 

Table 10-6 Frac-Data N x 56/64k Channel Diagnostic Selections and Messages (6521) 

Field Selection Description

Bit Error Rate These values are 
not selectable by 
the user. 

This read-only field is used to indicate the bit error rate when Pattern Genera
is started.

Total Bit Errors These values are 
not selectable by 
the user. 

This read-only field is used to indicate the total number of errors for the elap
time.

Elapsed Time These values are 
not selectable by 
the user. 

This read-only field specifies the elapsed time since the Pattern Generation
started and the pattern has been synchronized.

Off - when Pattern Generation is set to None.

NoSync - when Pattern Generation is set to 511 or 2047, but the pattern is 
currently being detected.

Elapsed Time - is displayed in italics since the actual value indicates days, ho
minutes and seconds.

Loopback Status Read-Only Shows any currently active loops on the channel.
No TimeSlot indicates timeslot is not assigned to channel and therefore the l
back cannot be started.

[Comm Error], [Comm Timeout] indicates communications problems with th
platform card.

Remote Loop-
back Status

Read-Only Shows current remote loopback status for the channel.
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Current Pattern Read-Only Shows current remote loopback status for the channel.

Local Loopback ToChan, ToNet, 
None, DTE-LL, 
DTE-RL, 
PN127Loop

Specifies the available local loopbacks. 

ToChan loops the data back to the channel interface.

ToNet loops the data back towards the network. 

DTE-LL, DTE-RL and PN127Loop are read-only and indicate the presence o
network-initiated or DTE-initiated loopback. If any of these are in effect, a ma
ager-initiated loopback cannot be started on that channel.

Remote Loop-
back

Off, On Allows you to send a PN127 Loop-up pattern into the network.

If a Local Loopback is active, a Remote Loopback cannot be performed

Pattern Genera-
tion

None, 511, 2047 Allows a test pattern to be sent to the network. If both the Remote Loopbac
Pattern Generation are started at the same time. the Remote Loopback is s
first and then the Pattern is sent.

If a Local Loopback is active, Pattern Generation cannot be started.

Notes: 

1. Dashes in the interface type indicate the channel is not present. An option card may be missing. When the int
type is displayed, but the selections contain dashes, the option type cannot be tested through the current screen

2. Local Loopback, Remote Loopback and Pattern Generation are not available on unconfigured channels.

3. If a network loopback is started on a channel while in the diagnostics screen, the user must try to select a Loc
back to see the loopback. Remote Loopback and Pattern Generation indicates that the network loopback is active
not update the Local Loopback selection.

Table 10-6 Frac-Data N x 56/64k Channel Diagnostic Selections and Messages (6521)  
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DSX-1 Channel Diagnostics (6521 Frac-Data Card)

The DSX-1 Channel Diagnostic selections are shown in Table 10-7, which presents diagnostic 
selections.

Misc

Frac-Data Card Monitor Menu

The Frac-Data Monitor menu is used to access the monitor screen for the DSX-1 and Nx56
channels. Figure 10-8 illustrates a typical screen.

Figure 10-8 Frac-Data Card Monitor Menu Screen (6521)

• DSX-1 Channel Monitor

DSX-1 Channel monitor screen shows configuration, diagnostics, and alarm information for
DSX-1 channels on the Frac-Data card. Refer to Table 10-8 for the monitored selections.

Table 10-7 Frac-Data DSX-1 Channel Diagnostic Selections and Messages (6521)

Field Selection Description

Local Loopback ToChan, ToNet, None Specifies the available loopbacks.
ToChan loops the data back to the channel interface.
ToNet loops the data back towards the network.

Table 10-8 DSX-1 Channel Alarm Values (6521) 

Field Values Description

Alarms LOS Red alarm, Loss of Signal Detected

OOF Red alarm detected

Yellow Yellow alarm detected

None No alarms

Metroplex 6521 Monitor
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• N x 56/64k Channel Monitor

N x 56/64k Channel monitor screen shows the configuration, diagnostics, alarm and status 
information for the N x 56/64k channels on the Frac-Data card. Table 10-9 describes additional 
status values.

Table 10-9 N x 56/64k Channel Status Values (6521)

Field Values Description

TX(RTS) Off, On Displays the current status of the local DTE interface RTS lead.

RX(DCD) Off, On Displays the current status of the local DCD lead.

DTR Off, On Displays the current status of the local DTE interface DTR lead.

RL/LL Off, RL, LL Displays the current status of the local RL and LL leads.

TM Off, TM Displays the current status of the TM lead.
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